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License Agreement
In return for payment of a onetime fee for this software product, the Customer receives from
Minisoft, Inc. a license to use the product subject to the following terms and conditions:
♦

The product may be used on one computer system at a time: i.e., its
use is not limited to a particular machine or user but to one machine at
a time.

♦

The software may be copied for archive purposes, program error verification, or to replace defective media. All copies must bear copyright
notices contained in the original copy.

♦

The software may not be installed on a network server for access by
more than one personal computer without written permission from
Minisoft, Inc.

Purchase of this license does not transfer any right, title, or interest in the software product
to the Customer except as specifically set forth in the License Agreement, and Customer is
on notice that the software product is protected under the copyright laws.

90-Day Limited Warranty
Minisoft, Inc. warrants that this product will execute its programming instructions when properly installed on a properly configured
personal computer for which it is intended. Minisoft, Inc. does not warrant that the operation of the software will be uninterrupted or
error free. In the event that this software product fails to execute its programming instructions, Customer’s exclusive remedy shall be to
return the product to Minisoft, Inc. to obtain replacement. Should Minisoft, Inc. be unable to replace the product within a reasonable
amount of time, Customer shall be entitled to a refund of the purchase price upon the return of the product and all copies. Minisoft, Inc.
warrants the medium upon which this product is recorded to be free from defects in materials and workmanship under normal use for a
period of 90 days from the date of purchase. During the warranty period Minisoft, Inc. will replace media which prove to be defective.
Customer’s exclusive remedy for any media which proves to be defective shall be to return the media to Minisoft, Inc. for replacement.
ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS IS LIMITED TO THE 90-DAY DURATION OF THIS
WRITTEN WARRANTY. Some states or provinces do not allow limitations on how long an implied warranty lasts, so the above
limitation or exclusion may not apply to you. This warranty gives you specific rights, and you may also have other rights which vary
from state to state or province to province.
LIMITATION OF WARRANTY: Minisoft, Inc. makes no other warranty expressed or implied with respect to this product. Minisoft,
Inc. specifically disclaims the implied warranty of merchantability and fitness for a particular purpose.
EXCLUSIVE REMEDIES: The remedies herein are Customer’s sole and exclusive remedies. In no event shall Minisoft, Inc. be liable
for any direct, indirect, special, incidental, or consequential damages, whether based on contract, tort, or any other legal theory.
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♦

A display capacity of up to 66 rows and 255 columns.

♦

Windows screen handling with support for pull-down menus, menu
bars, side bars, and mouse; support for cutting and pasting information
between windows. Resizable windows with scalable fonts.
Customizable screen display with variable True Type font selection.

♦

Status line and user-defined custom menu with sub menu items.

♦

Support of display enhancements for color or monochrome, including
inverse video, underlining, blinking, and security.

♦

Eight user-definable function keys display on screen, including support for System function key hierarchy.

♦

Support for COM1, COM2, COM3, and COM4. Baud rate support
from 300 through 38,400.

♦

Comprehensive Command Language, including auto login, auto logoff,
modem dialing, disk backup, and DDE commands.

♦

Multi sessions through one LAN connection.

♦

ASCII and binary file transfer between the HP minicomputer and PC
through a modem or direct connection with data compression. Xmodem
protocol for file transfers with BBS (bulletin board systems) and Unix
host machines. FTP (File Transfer Protocol) client included.

♦

Run host applications in the background while a Windows word processor or spreadsheet is being used.

♦

PC to host printing. Direct output of most Windows-based word processing, graphics, and spreadsheet packages to host printers.

♦

Support for WinSock, TCP/IP, NSVT, and Telnet network connections.

♦

HP 2392A, 700/92 terminal emulation support for both character and
block mode operations, configurable terminal memory.

♦

DEC emulation, allowing 25-line display, keyboard remapping, and
color configuration for VT52, VT100, VT220, and VT320 terminals.

v
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♦

Type-ahead, destructive backspace, keyboard remapping.

♦

Capture screen display to local disk file.

♦

DDE (Dynamic Data Exchange).

♦

Modem dialer and phonebook.

♦

Script/macro recorder.
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CHAPTER 1: INTRODUCTION

MS92

VERSIONS

The product as a whole is called Minisoft 92 or MS92; otherwise, specific
versions are referred to as:
♦

WS92 for Windows Sockets (WinSock) version. WS92 comes in 32bit version.
If you have used an older version of Minisoft 92, previous names for
WS92 included Win92.

♦

If your PC does not have Windows, but runs under DOS, contact
Minisoft for a DOS92 manual.

HARDWARE
WS92

AND SOFTWARE REQUIREMENTS

REQUIREMENTS

WS92 has the following hardware and software requirements:

MINISOFT 92

♦

IBM or compatible PC, 486 (minimum)

♦

Standard VGA video card or better

♦

8 MB RAM

♦

Windows 95/98/ME or NT/2000

♦

WinSock-compliant TCP/IP stack—which includes a WINSOCK.DLL
file—must be present for network connections
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INSTALLATION
Files on CD include:
♦

WS92 Software

♦

WS92 manual in PDF format

♦

Adobe Acrobat Reader executable software

♦

NFT

INSTALLING WS92

VIA WINDOWS

To install WS92 using the Windows setup program:
1. Insert the WS92 CD into your CD-ROM drive.
2. From the taskbar select Run.
3. In the Command Line text box, type:
drive:\SETUP.exe

Where drive is the letter of your CD-ROM drive.
4. The default installation directory is C:\Minisoft\WS92.
5. Respond to the setup program prompts as directed.
Setup performs the following:

1-4

♦

Creates a directory for the WS92 software. Default is
C:\Minisoft\WS92\.

♦

Extracts files from the distribution CD to your hard drive.

♦

Creates a Minisoft entry in the Start > Program menu to Run and
uninstall MS92_32.

♦

Creates user icons on the desk top.

♦

Installs the Win92 display font in the System Font Directory.

♦

Registers the font.
MINISOFT 92
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ELIMINATING

THE

SPLASH SCREEN

AND SETTING A ONE COPY

EXECUTABLE

Special naming of the WS92 executable can do the following:
♦

Eliminate the Splash screen. Rename WS92_32.EXE to:
WS92_32Q.EXE

♦

Allow only one copy to be executed (one session). Rename
WS92_32.EXE to:
WS92_32S.EXE

♦

Eliminate the Splash screen and allow only one copy to be executed.
Rename WS92_32.EXE to:
WS92_32QS.EXE

WINSOCK-COMPLIANT TCP/IP STACK
WS92 relies on a WinSock-compliant TCP/IP stack for making network
connections. If you wish to make a network connection, you must have a
WinSock-compliant TCP/IP stack before you can use WS92. Serial and
modem connections are also supported.

ADDING SET

STATEMENT FOR

WS92

In addition to installing WS92 for Windows 95 and 3.11, you may need to
edit your AUTOEXEC.BAT file for Windows 3.1, 95 and 98 or enviroment
for Windows NT so that MS92 can find its configuration, message, and
script files anywhere on the PC.
Where dir is the directory where the program is installed, you will need to
set the directory of WS92. For Windows 3.1, 95 and 98 you can edit the
Autoexec.bat file and add the set statement:
SET WS92=[The Directory where WS92 is installed]
example:
SET WS92=c:\minisoft\ws92
MINISOFT 92
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You must reboot Windows 95 and 98 after editing the Autoexec.bat file to
finish the modification.
For NT, right mouse click on My Computer, select Properties, select the
Enviroment Tab in the box labeled ‘Variable’. Type WS92 then tab to the
next box labeled ‘Value’ and type in the directory where WS92 was installed.
Example:
C:\minisoft\WS92
After setting the WS92 diretory you can check to see that it was set correctly by going to the DOS command and typing SET followed by a carriage return. An entry will appear and read as WS92=C:\minisoft\WS92, if
C:\minisoft\WS92 is the directory where you installed WS92.
Note: You must have a WINSOCK.DLL installed on your PC in order for
WS92 to execute.
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STARTING WS92
To run WS92:
1. Select Minisoft / WS92 from the START > Program shortcut menu or
select the WS92 icon on your desktop.
2. If the default.w92 file is not found, the following set of dialog boxes
will be displayed.

3. Select OK. Later change the colors to the default, followed by a Config
Save to create the default.W92 to be used in subsequent connections.
MINISOFT 92
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4. If you have not yet established a connection, an offline message may
appear:

5. Click Configure. The Communications Type dialog box appears.
6. Select:
Serial - Makes a modem, direct, or MUX connection.
Telnet - Your PC will connect to a Unix or Telnet-capable system.
NS/VT - Connects to an HP e3000.
OFFLINE - Waits for action, when an action is prompted the OFFLINE
dialog box appears giving you the options to Retry, Configure, Load
or Exit WS92.
Note: If you have seen any of the previous dialog boxes, or have changed
any of the above settings, be sure to do a Config Save.

NEED

FURTHER INFORMATION....

Chapter 2
Chapter 4
Chapter 5
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Configuration Instructions
Making a Serial Connection
Making a Telnet or NS/VT connection
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WS92

CONFIGURATION

When running WS92 for the first time, you must establish configuration
settings in order to connect to a host computer. Configuration settings will
allow you to control many options including colors and fonts of the WS92
display, and function keys that initially display.
Configuration settings for WS92 are stored in a configuration file, which
has the extension .W92. The configuration file saves the settings you specify
under the Config menu, current screen size and position.
For example, if you position the WS92 window in the upper right corner of
the monitor and save the configuration, the WS92 window will display at
that size and position the next time you run the configuration. In this way,
you can display multiple WS92 sessions by saving separate window positions to separate configuration files (mainly network connections).

DEFAULT

CONFIGURATION

The first time you run WS92, the software runs a default configuration file,
DEFAULT.W92. Adjust the default configuration so the settings correspond
to your system. Save the settings by selecting the Save command from the
Config pull down menu.
Unless a configuration file is associated with a shortcut, the default configuration file is used.

MINISOFT 92
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LOADING

A NEW CONFIGURATION FILE

Note: Loading a new configuration file with the connectivity changed will
cause WS92 to initiate a new host session, disconnecting your current network session.
To run a new configuration from within WS92:
1. Select Load from the Config menu. The Open dialog box appears:

2. Select the name of the configuration file you wish to run, then click
Open.

2-4

MINISOFT 92

CHAPTER 2: CONFIGURING MS92

RUNNING

FROM

COMMAND LINE

When installing WS92 as a Program Item through Windows Program Manager, include a configuration file name in the Command Line field, similar
to the Windows 95 example shown below. In this example, the configuration file HP3000.W92, located in the WS92 subdirectory, will be loaded
automatically when you run WS92.

CREATING

SHORTCUT ICONS WITH DIFFERENT CONFIGURATION

FILES

Create separate WS92 icons to run separate configuration files. For example, if your PC has a serial connection to an HP e3000 host and a network connection to an HP9000 host, setup two separate WS92 icons to
make these connections, as follows:
1. From Windows Program Manager, create two separate short cut items
similar to the following:

MINISOFT 92
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2. Under the Short cut properties, insert the correct configuration file
after the Ws92_32.exe, as shown in the following dialog box.

3. To run either configuration, double-click the icon of your choice.

2-6
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SAVING

A CONFIGURATION

To save a configuration, select Save from the Config menu. The current
configuration settings are saved to the configuration file currently in use.
If this is the first time you have run WS92, the settings are saved to
DEFAULT.W92.

SAVING

A NEW CONFIGURATION

WS92 allows you to create alternative configurations for various connections. For example, you may have separate configuration files to run serial,
network, HP e3000 or HP9000 host connections.
To save a new configuration:
1. Select Save As from the Config menu. The following dialog box appears:

2. Enter a file name, such as HP e3000, in the File Name text box. The
.W92 extension is appended automatically. You can also select the
name of an existing file. This causes WS92 to prompt you for whether
to overwrite the existing file, as shown in the following dialog box.

MINISOFT 92
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CONFIGURING

THE CONNECTION

Your connection type will be serial or network. If it is a network connection, you must configure the network type and HP e3000 node name or IP
address in WS92.
If you plan to use WS92 to dial a host computer over a modem or connect
using a DTC, configure for a serial connection.

TERMINAL

CONFIGURATION IN HP MODE

Terminal option information helps the host computer identify your terminal. Handshaking and screen options are also included in order for the data
from the host to display properly on the PC’s monitor.
Note: Terminal options differ according to whether you are running in HP
or VT mode. For HP terminal settings, use the default settings unless you
have had problems and have been advised to use special settings.
To configure terminal options for HP mode:
1. From the Config menu select Terminal. The Terminal Configuration
dialog box appears as shown in the following dialog box.
2. Configure the following settings. For default settings, click Defaults.
When you have finished customizing your settings, click OK.

NEED

FURTHER INFORMATION....

Chapter 3
Chapter 4
Chapter 5
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Emulating a DEC Terminal
Serial and Modem Connection Instructions
Network Connection via WinSock
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Options for Handshaking should be off for HP e3000, as most applications will set them as needed. HP9000’s running certain applications
may need to have straps Inh DC2 (H) and Inh HndShk (G) selected.

Options Available:
Terminal ID: Enter the ID number of the terminal you are emulating.
The 2392A and 700/9x are more recent HP terminals, which certain HP
software may not recognize. You may change the terminal ID by typing: 2624A, 2622A. This will not change the emulation features of WS92
but will allow the HP host software to recognize the terminal.
Some HP software packages support the 132 column on-screen display
features of the 700/92 terminal. You must enter 70092 in the Terminal
ID box for this feature to work in WS92.
Screen Options: Select the following variables for your terminal display
screen:
Start Col: Defines the horizontal column in which to begin displaying
text (a value of 0 begins at the far left).
Local Echo: Causes type to appear immediately on your PC screen.
Default is OFF.

MINISOFT 92
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Caps Lock: Capitalizes all typed characters. Default is OFF.
Bell: Activates your PC’s audio alarm. Default is OFF.
InhEolWrp (C): Inhibits line wrapping. Default is OFF.
Line/Page Mode (D): Select Line or Page to transmit data to the host by
line or page; Default is LINE.
Handshaking: Select options to regulate the flow of data between WS92
and the host:
XmitFnctn (A): Transmits functions associated with control characters.
Default is OFF.
SPOW (B): Causes the spacebar to write spaces over characters. Default is OFF.
InhHndshk(G): Makes a connection with InhDC2 to control handshaking. Default is OFF.
Inh DC2 (H): Works in conjunction with InhHndShk to control handshaking. Default is OFF.
Esc Xfer (N): Controls the transfer of escape sequences to a printer.
Default is OFF.
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CONFIGURING
BUTTON

THE INTERFACE

BAR AND STATUS BAR CONFIGURATION

WS92 allows you to configure specified buttons to be used in the toolbar
across the top of the screen, and define items you wish to have tracked in
the status bar across the bottom of the screen.
Note: In VT emulation mode, VT function keys are displayed in the button bar. You can hide the button-bar display while in VT emulation mode;
select Hide the Button Bar from the Config Bar-menu.
To configure the button bar and status bar:
1. From the Config menu select Bars.
2. The Configure Menu Bars dialog box appears. The appearance of this
dialog box varies according to the type of emulation you are running.
See Figure 2-1 for VT mode menu bar configurations and Figure 2-2
for HP mode menu bar configurations.

NEED

FURTHER INFORMATION....

Chapter 2
Chapter 3
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Custom Menu - Enabling Customer Menu Items
Emulating a DEC Terminal
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Figure 2-1

Figure 2-2
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3. The buttons listed above are shortcuts to commands that are available
from your pull-down menus. Select the items you wish to have displayed in the button and status bars. If you do not want the button bar
to be displayed, click Hide the Bar.

CUSTOM

MENU

From the Configure Menu Bar dialog box, the Custom Menu box must be
selected to allow items to be added to the Menu Bar. Enter the name of a
.BUT file in the file name box. For an example of a .BUT file, see
MS92B32.BUT from the WS92 directory.

MINISOFT 92
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EXAMPLE .BUT

FILES

Each line in a .BUT file is a separate menu line. The item to the left of the
‘=’ is the label or description. The item to the right of the ‘=’ is the command or script file to be executed. Any letter in the description proceeded
by an ampersand (&) will cause that letter to be displayed with an underline. This allows keyboard selection of the item. If the item is a script file,
it should have an extension of .S92.
If you plan to implement a pop-up submenu for your Custom Menu define
the items for the custom menu. Precede the name of the main or popup
menu with a _P and sub menus under the main menu with an _S (see following example).

EXAMPLE 1
The following example generates a Custom Menu that looks like the following. Note that the custom section is case sensitive.

[buttons]
Clear Screen=DISPLAY “^[H^[J”
LOGON=LOGON.S92
EXIT=SEND “EXIT”
BYE=SEND “BYE”
HARD EXIT=HARDEXIT
BACKGROUND=BACKGROUND
_PVendors=
_SMicrosoft=Tell Microsoft
_SHewlett Packard= Tell HP
_SIBM= Tell IBM
2-14
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EXAMPLE 2
In addition to the file described above the following commands have been
added to the Minisoft scripting language.
1. MAINMENU [title] adds a new option to the main menu bar. Only
one option can be added. If the command is executed again, it will
overwrite the previous menu title. This would show on the Menu bar
instead of the word Custom.
2. SUBMENU [title] adds a sub-menu option under the heading specified under MAINMENU. Up to 24 may be added.
3. ONMENU [number] [action] specifies the action to take when submenu [number] is selected. Any letter proceeded by an ampersand (&)
will cause that letter to be displayed with an underline. The following
example will generate a Custom Menu with the following:
Tasks
Clear
Go To Background
Logon Script
MAINMENU Tas&ks
SUBMENU &Clear
SUBMENU Go To &Background
SUBMENU &Logon Script
ONMENU 1 DISPLAY “^[H^[J””
ONMENU 2 BACKGROUND
ONMENU 3 LOGON.S92
Note: The custom section is case sensitive.

MINISOFT 92
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FONT

CONFIGURATION

WS92 allows you to choose the font that displays on the terminal emulation screen. The default font is Win92, which resides in the W92.FON file.
To configure the WS92 display font:
1. Select Font from the Config menu. The Font dialog box appears:

The Font dialogue box will allow the choosing of different fixed pitch
fonts with the option to change the Font Style. Further options available
are Auto-size Font and Squeeze 132 column font.
When Auto-size Font is selected, the font will be resized to fit the window.
This will happen when the window is resized and/or the number of columns to be displayed changes. If the window is too small for the selected
font, a different font will be used. When the window is made larger and/or
the number of columns changes so the selected font will fit, the font will
revert to the original selection. If no font is found, a message will be displayed and the window size will not be changed.
If Auto-size Font is not selected, the Font Size will be available. If the
selected size is larger than what can be displayed in the window, scroll
bars will be added.
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Squeeze 132-column font will only be used with low-resolution display
(640 x 480). This calls for a special font that will be smaller in the last 20
columns so a full 132 columns can be displayed. For this special font to be
used, this option must be checked, display must be in 132 columns, and
Config... Screen Configuration... ‘Suppress Scroll Bar on Maximized
Screen’ must be selected.
2. When you have made your selections, click OK. The Screen displays
the button bar and status bar as you specified. Note, selecting OK activates your choices for just the current session. WS92 does not save
any configuration changes permanently until you select Save or Save
As from the Config menu.

SPECIAL

CONFIGURATION

The special configuration settings allow you to configure for destructive
backspace, ignoring host commands, and other options.
To set special configurations:
1. Select Special from the Config menu. The Special Configuration dialog box appears:
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2. When you have finished customizing your settings, click OK.
Note: Clicking OK activates your choices for the current session only.
WS92 does not save any configuration changes permanently until you
select Save or Save As from the Config menu.
Options available in the Special Configuration dialog box are as follows:
Serial Numbers: Specifies a string identifying WS92 as the terminal emulator. Some host applications emit an escape sequence that asks the emulator to respond with a 9-byte or 14-byte string. WS92’s default 9-byte
string is MS92 BEST and default 14-byte string is MS92 IS BETTER.
Some host applications, however, expect a string that represents a valid
WRQ serial number (Reflection emulator). In this case, configure the
WS92 serial number according to the WRQ syntax shown in the following table.
Ho st Escape Sequence

Defaul t Seri al Number

WRQ Syntax

[Esc]* s12 3 4 5 ^

MS9 2 BEST

WRQ-5 5 4 48

[Esc]* s12 3 4 7 ^

MS9 2 IS BETTER

W0 1-5 2 1L0 5 5 48

For example, the number WRQ-55448 is a valid WRQ serial number for
the 9-byte string, and W01-521L05548 is a valid WRQ serial number for
the 14-byte string.
Some host software assumes Reflection to be the terminal emulator if any
character sequences respond. If no response is received, the software assumes the terminal emulator to be an HP Terminal. To emulate the HP
Terminal and not WRQ, leave the 9-byte and 14-byte fields blank and
enable the Ignore Host Commands option (see Miscellaneous Options).
When these fields are blank and host commands are ignored, WS92 does
not respond to any escape sequence, thereby reacting as an HP terminal.
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Miscellaneous Options:
Destr. B-Space: Causes the backspace key to erase characters as it moves
the cursor to the left.
Suppress Bell: Allows you to disable the PC bell, which many applications use to report error conditions or sound warnings to the user.
Raw Keys: Allows you to use extended ASCII codes without translating them into equivalent HP characters.
Ignore Host Commands: Forces WS92 to ignore all host commands of
the type [esc]& oC and [esc] & OF. This configuration allows some
host applications to treat WS92 as a terminal rather than an emulator.
Ignore Unsupported Cmds: Forces WS92 to ignore the host commands
it does not support.
Return = Enter in Block Mode: Allows the PC Return key to emulate
the HP Enter Key when in block mode. This is best used when the ENTER key is mapped as a CR. By using this feature, less training time is
required for first time HP Terminal users.
Long Phone Numbers: This option requires a new phone number file
(Ldial92) that can hold numbers up to 45 digits. When selected the Dial92
file is not available otherwise when unselected the Dial92 file is used.
No changes are made to the Dial92 file.
SGA Scale delay option: When <ESC *dr> , turn off cursor, is received
WS92 waits 1 second for keyboard input before reading the comms.
This allows Ecometry’s scale input device to complete writing through
the keyboard, since Ecometry host software does not wait.
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Action on Disconnect: Select one of the following options to specify the
action WS92 will take when a network line is disconnected.
Ask: Presents you with a dialog box for Retry, Configure, Load, or
Quit.
Retry: Always attempts to reconnect after the connection has been
dropped or lost.
Offline: Disconnects you from the host through the network line but
leaves the terminal window open. When you select the Enter key the
terminal window then opens the Offline dialog box with the options of:
Retry, Configure, Load, Offline, or Exit.
Exit: Takes you completely out of the terminal emulator without prompting for any actions.
Confirm Quit on Close Screen: Displays a dialog box asking you to confirm the exit. Uncheck this option if you do not wish to be asked. This
option is only in effect when attempting to quit WS92 using the top right
corner X button (close window).
DDE: (Dynamic Data Exchange) Allows you to create a real-time link
between WS92 and other Windows applications that support DDE.
Changes to data in the original application will then appear when accessed by the linked application.
The application in which the data originates is called the server application, and the application that uses the data is called the client application. WS92 can be either a client or server application. A DDE link
requires that both the server and client applications be active at the same
time.
Not all Windows applications support DDE; consult your application’s
user manual for further information on how it supports DDE. For details
on using WS92’s DDE commands, see Chapter 9.
Timeout: The maximum number of seconds WS92 will wait for an
acknowledgment after sending a DDE message.
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Service Name: The name by which DDE client applications identify
WS92 as a DDE server application.
Enable: Select this box to use DDE.
Right Mouse Button:
Ignore: Ignores the Right Mouse button.
Enter: Treats the Right Mouse button as numeric ENTER key.
Copy and Paste: Copies selected data to the clipboard, then pastes information where the cursor is presently located. If a selection has not taken
place, data from the clipboard will be pasted.
Copy or Paste: If selected, data will be copied. If not, data will be pasted
where the cursor is located.
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DESTRUCTIVE

BACKSPACE

There are differences in the implementation of destructive backspace on
various hosts. You can implement a destructive backspace in one of two
ways, special configuration or keyboard remapping.
Note: For special configuration of the destructive backspace, see Destr. BSpace under the heading Special Configuration in this chapter. For keyboard remapping, see heading Keyboard mapping in this chapter.
HP e3000 MPE/MPEiX
MPE does not directly implement a destructive backspace. To simulate
this function, MS92 will transmit the following three characters:
^H ^H [CHR(8)+CHR(32)+CHR(8)]

Select the destructive backspace option under Config : Special, or map a
key to this string sequence.
HP9000 HPUX
Use the normal unmapped backspace key.
DEC Alpha
Default destructive backspace character on DEC Alpha systems is the Delete CHR(127):
DEL [CHR(127)]

A VT DEL map button will be

Del and a Backspace key will be

added.
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Other UNIX
Use:
^H ^H [CHR(8)+CHR(32)+CHR(8)]
or
DEL [CHR(127)] or ^H [CHR(8)].

Note: Clicking OK activates your choices for the current session only. WS92
does not save any configuration changes permanently until you select
Save or Save As from the Config menu.
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SCREEN

CONFIGURATION

The Screen Configuration settings allow you to configure cursor shape,
function keys, screen size, screen page memory, and other factors affecting screen appearance.
To set the screen configuration:
1. Select Screen from the Config pull down menu. The Screen Configuration dialog box appears as shown below.
2. Refer to the list of options below to customize your settings. For default settings, click Defaults.
3. Click OK. Note, selecting OK activates your choices for just the current session. WS92 does not save any configuration changes permanently until you select Save or Save As from the Config menu.
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Options available:
Cursor Shape: Selecting Box displays your cursor as a vertical rectangle.
Selecting Underscore displays your cursor as a horizontal base line.
FnKey Default Setting: Configures WS92 System function keys (modes
keys) or User-defined function keys (user keys) to display at start-up.
Screen Width: Select 80 - 255 column width. You can also specify 80, 132,
or 200 column width from the dropdown Options pull down menu.
Screen Height: Allows you to specify a display screen of 24 through 66
rows.
Title: The name that is displayed on the title bar of the window, also shown
in the TASK bar (72 Character limit).
Screen Pages: Configures the amount of terminal display memory. The
more screen pages you configure, the greater amount of terminal memory
you will have. For example, 10 pages of screen memory is equal to 240
lines of text. You can use the vertical scroll bar, Page Up / Page Down,
and CTRL -/CTRL- keys to view text in terminal memory that has
scrolled off the top of the display screen. The maximum number of screen
pages available is 99.
Note: You must save the configuration, exit WS92, and then restart
WS92 with this configuration in order to activate your changes to the
screen pages.
Scroll Jumps: This option controls the number of new lines that will be
displayed simultaneously. Under the default of 0, new lines are displayed
one by one and scrolled up. Scroll Jumps can be used to increase the
scrolling speed. This is only used when Bypass Window Scrolling is
selected.
Note, when several new lines are displayed and scrolled at once, the
perceived speed can appear slower than the actual speed. Try displaying a large file with scroll jump set at 0 and then at 24, timing each for
how long it takes to see the end of the file. Though 24 might appear
slower, you may find it is significantly faster.
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Suppress True Underlining: Select this option to turn off text underlining
that is being transmitted from the host computer. This will allow the
underlining enhancement configured in the color configuration to be the
only active enhancement. For information on configuring enhancements
for underlining, see Color configuration, later in this chapter.
Center Screen: Enabling this option centers the screen within the window
size, framing the screen. If disabled, the screen displays within the window, top left justified with unused space toward the bottom left.
Bypass Windows Scrolling: By default scrolling is controlled by the video
card. To by pass the video card scrolling, select this option and WS92
will do the scrolling within its own code.
Show Scroll Bar: Displays vertical and horizontal scroll bars. The horizontal scroll bar appears at the bottom of the screen when auto-size font is
not selected and the WS92 window does not have the room to display all
columns requested.
Enabling the “Always” option, will cause a scroll bar to appear at all
times. Selecting the “If screen is not maximized” option, shows your
scroll bar only when unmaximized. Choosing “Never”, causes your scroll
bar never to be shown. The CTRL- or CTRL- or Page Up and Page
Down buttons on the enhanced keyboard can be used for scrolling when
the scroll bar is hidden. Not displaying a scroll bar allows larger fonts to
be used in 132 / 200 column screens.
When in 132 column mode with display properties of 640 by 480 resolution, either “Always” or “If screen is not maximized” options must be
selected.
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To quickly move around in the screen memory, press one of the following key combinations:
HOME
END
CTRL-HOME
CTRL-END

Beginning of current line (far left)
End of current line (far right)
Home Up (top left of screen)
Home Down (bottom left of screen)

Suppress True Blinking: Selecting this option turns off blinking that is being transmitted from the host computer. This will allow the underlining
enhancement configured in the color configuration to be the only active
enhancement. For information on configuring enhancements for blinking, see Color configuration, later in this chapter.
Map Form Feeds to Line Feeds: Converts form feeds that a host application sends to the screen into line feeds. This setting does not affect printing. Default setting is OFF.
Text Font for Function Keys: Uses the currently default windows font as
the font for function key labels. This setting is particularly useful for
non-English character sets.
Wrap Keyboard Selections: Selecting this option allows Inverse Video selection when using shift > arrows keys. Otherwise Rubber Band selection is applied.
Wrap Mouse Selections: Allows Inverse Video selection when using a left
mouse selection.
Wrap Shift Mouse Selections: Selecting this option allows Inverse Video
selection when using shift > left mouse selection. Otherwise Rubber
Band selection is applied.

NOTE....
Minisoft allows two selection types: Inverse Video and Rubber Band. Rubber Band
allows outline selection without line wrap. Inverse Video, line wraps from line to
line.
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COLOR

CONFIGURATION

Color configuration settings allow you to make separate selections for foreground and background colors for all the configuration options available
for your terminal mode: HP or VT. For information on enabling VT mode
see Emulating a DEC terminal in Chapter 3.
HP MODE: For HP 2392A and HP 700/9x terminals, configure enhancements for halfbright, inverse, underline, blinking, and any combination
of these.
VT MODE: For VT52, VT100, VT220 and VT320 terminals use the ANSII
Color settings.
The Show Attributes utility, accessed via the Trouble menu, can aid you in
configuring color enhancements in HP mode.
To configure the color enhancements of your terminal emulation screen:
1. Open a host session in WS92, and run a host application that uses
screen enhancements intensively.
2. Select Colors from the Config menu.
3. In the Color Configuration dialog box, select Default Colors, and then
click OK. The host application’s enhancements are shown in the default color scheme.

2-28

MINISOFT 92

CHAPTER 2: CONFIGURING MS92

To identify the type of terminal enhancements on your screen, select
Show Attributes from the Trouble menu. As you move the pointer across
the screen, the status box tells you whether the field is halfbright, underline, inverse, blinking, or secure — or a combination of these. The
Attribute dialog box also describes whether it is the start or end of a
field, or start or end of a line drawing. The pointer’s row and column
position is also reported, as well as the name of the enhancement attributes. Use the information in the status box to help you choose the
enhancements that need to be changed in the Color Configuration dialog box as shown in the attributes dialog box.
4. Customize the color configuration by selecting Colors from the Config
menu which displays the Color Configuration dialog box:

Note: The Color Configuration dialog box in VT mode differs slightly
from the HP mode shown here. The process for configuring color enhancements is the same in HP and VT modes.
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5. Match the enhancement attribute reported in the Attribute field of the
status box in step 3 to the enhancement combination in the Color Configuration dialog box, shown above. For example, if the enhancement
attribute from step 3 is the @ symbol, this would be the normal attribute. This should also match the first entry of the (HP Code) column
in the color configuration dialog box.
Note that enhancements for the function keys are not defined by a
character, but the label, “Function Keys”.
Each combination of enhancements is comprised of text and background color. Think of each enhancement as a block on the screen,
where the color of the text appears on a background color.
6. Click a text or background color block for the enhancement you wish
to change, and change the color by clicking one of the colors from the
palette. Click OK to see the results of your changes. You may need to
repeat steps 4 through 6 several times to arrive at the exact configuration you desire.
Note: Clicking OK activates your choices for the current session only. WS92
does not save any configuration changes permanently until you select
Save or Save As from the Config menu.
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KEYBOARD

MAPPING

There are keys that exist on a terminal that do not exist on a PC keyboard,
you must map terminal keys to PC keys in order to send certain commands
that are available on a terminal. WS92 allows you to configure keyboard
mapping for both HP and VT terminals, depending on whether you are
running HP or DEC emulation (see Emulating a DEC terminal in Chapter
3).
To map the keyboard:
1. From the Config menu, select Keyboard: Mapping. The following dialog box will then be shown:

2. To map all keys to a default configuration, click Defaults.
3. To map keys manually, select a PC key you wish to map.
4. Then click Delete Map.
5. Select an option from the Mapping list box. For example, to map the
PC key to a terminal key, select Map to Terminal Key.
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6. Click the terminal key you wish the PC key to map. Then select Map.
7. Click Done.
Extend the number of PC keys available by clicking the Control, Alt, or
Shift options to create a key combination. For example, map the PC key
combination Ctrl-Shift-L to the HP Ins Ln key, as shown below.
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Map keys to send a string of characters, script command, or action to the
host computer.
To send a string of characters:
1. Select a PC key.
2. Select Map to String in the Mapping list box.
3. Type a string in the text box, as shown below, which maps the PC key
combination CTRL-ALT-L to the string “Hello MGR.MINISOFT” to
the host. In order for CR to work you will need <^M>. You could also
use the string text to send an escape sequence (see Appendix C for the
^[ escape code).

NOTE....
You can map more than one PC key or key combination to a single terminal key,
string, command, or action. However, you cannot map multiple terminal keys, strings,
commands, or actions to a single PC key or key combination.
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To send a script command or file:
1. Select a PC key.
2. Select Map to Script Command in the Mapping list box.
3. Type the script command or script file name in the text box. This will
map the PC key combination to the script command.
To send an action:
1. Select a PC key.
2. Select Map to Action in the Mapping list box.
3. Select an action from the list of options. For example, you can map the
PC Print Screen key to the terminal action “Print Current Page,” as
shown in the following screen shot.

You can map more than one PC key or key combination to a single terminal key, string, command, or action. However, you cannot map multiple
terminal keys, strings, commands, or actions to a single PC key or key
combination.
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TRANSLATION

TABLES

Note: If you need non-U.S. English fonts and plan to use Windows True
Type fonts, you will need font conversion tables.
WS92 uses Character Set Translation Tables to convert between different
character sets on PCs and the host computer. The size of these tables is
always 256 bytes. The tables reside in the same directory as WS92, where
WS92 looks for them during start-up. The tables may also be loaded dynamically, without having to stop and restart WS92. To do this run a script
file that includes the TABLOAD command. For more information, see
TABLOAD in the Script Language Manual.
The following shows the preset tables for MS92 for Windows available
with the TABLOAD command:
F uncti on

Transl ati on Tabl e

TAB LOAD Val ue

P C keyboard to host computer

HP _CHARS.TBL

1

Host computer to P C monitor

P C_CHARS.TBL

2

ASCII file transfer from P C to host

XLAT1.TBL

3

ASCII file transfer from host to P C, and
capture to disk

XLAT2.TBL

4

Host computer to P C monitor; for function
key labels

FK_CHARS.TBL

5

Host computer to P C slaved printer (local
print functions)

P T_CHARS.TBL

6

Copy-and-paste from WS92 to other
Windows applications

CUTCHARS.TBL

7

P aste from other Windows applications to
WS92

PASTE_CH.TBL

8

Default character sets in most Western European countries are as follows:

MINISOFT 92

HP 3000 - MP E/iX

HP ROMAN9

P C - MS-DOS

IBM Codepage 850 (Multinational)

P C - MS-Windows

Windows ANSI
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Appropriate translation tables are included in the zip file called XLAT.zip.
The WS92 setup program copies this file to your hard disk. The translation
tables in the XLAT.zip file are used to covert between different character
sets, as follows:
PC8ROM9.TBL
ANSIROM9.TBL
ROM9ANSI.TBL

from MS-DOS
from Windows ANSI
from HP ROMAN9

to HP ROMAN9
to HP ROMAN9
to Windows ANSI

If none of the translation tables are present in the PC’s working directory,
WS92 performs this conversion by default:
PC to host computer: Code Page 850 to Roman-9

No conversion is required for the host computer to the PC monitor when
using the default font Win92, as it is based on the Roman-9 character set.
Using the EURO Symbol
In the character sets that are relevant for MS92, the EURO symbol has the
following values:
Character Set

Deci mal Val ue

Hex Val ue

Windo ws ANSI

128

80

HP Ro man8

No t Available

No t Available

HP Ro man9

186

BA

The HP Roman9 character set (standard on HP e3000 servers) is an exact
copy of the HP Roman8 set except for the one character decimal 186 that is
used to be the currency sign ¤ and that is now used for the EURO sign. To
generate the EURO symbol in MS92, please do the following:
1. Verify that the font file W92.FON (C:\WINDOWS\FONTS) is dated
March 27, 2000 or later.
2. Copy the files from XLAT.zip to your MS92 directory, default
C:\MINISOFT\WS92.
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3. Run MS92.
4. Generate the symbol in one of the following ways:
a. With NUMLOCK on, hold down the left ALT key and type 0128 on
the numeric keypad.
b. Select Config > Keyboard > Mapping . In the PC area select the key
combination that you wish to generate the EURO symbol, usually Control + ALT + the letter E.
Select Map to String. Then enter the decimal value of the EURO symbol in HP Roman9, by holding down the left ALT key and entering
0186 on the numeric keypad.
Press the Map button, then select Done and save the configuration.
Now when you press ALTGR-E key combination you will generate
the EURO symbol.
Note: WS92 will also correctly convert the EURO symbol between HP
Roman9 and Windows ANSI in ASCII file transfer operations.
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USING

TRANSLATION TABLES WITH

NFT

NFT (and FTP) use a MDMFT.INI (or MDMFTP.INI) file to set translation table values. For example, to have extended characters convert correctly between Windows ANSI and HP-ROMAN9 when using NFT, add
the following lines to the file C:\WINNT\MDMFT32.INI:
[Translation]
UploadTable=C:\MINISOFT\WS92\ANSIROM9.TBL
DownloadTable=C:\MINISOFT\WS92\ROM9ANSI.TBL

Note: Use the appropriate Table.

MAKING XLAT

FILES

The size of these tables is always 256 bytes. The characters in this file are
substituted for the equivalent (indexed) character requested. If the file contains the binary values zero through 255, no change would take place.

EXAMPLE
If the 33rd character (Decimal value 32, Hex 20) is replaced with the 66th
character (Decimal value 65, Hex 41), all blank spaces will be replaced
with the letter A.
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THE WS92

SCREEN

WS92 allows you to run a host session from your PC as if your PC were a
terminal connected directly to the host computer. WS92 also allows you to take
advantage of the PC’s CPU, data storage capacity, and printer while you are
running a session on the host.
To run WS92, double click the WS92_32 icon. The terminal emulation window
displays, as shown below. You will notice it has the same properties as any
standard window in the Windows environment:
♦

NEED

♦

control boxes

♦

minimize/maximize buttons

♦

scroll bars and boxes

♦

title and menu bars

FURTHER INFORMATION....

Chapter 6
Chapter 7

MINISOFT 92

sizable borders

Transferring Files
Printing from WS92

3-3

CHAPTER 3: RUNNING A HOST SESSION

Screen Size Buttons
Title Bar
Menu Bar
Button Bar

Vertical Scroll Bar

Status Bar
HP Function Keys
Function Key Scroll Bar

TITLE

BAR

Click and drag the title bar to move the WS92 window anywhere on your
screen.

MENU

BAR

The Menu Bar is located at the top of the WS92 window, below the title bar.
You may choose from the following menus: File, Edit, Config, Options, Trouble,
Print, Help and Custom. Click on a menu title to display all the menu items
available. Users without a mouse can pull down a menu by pressing the ALT
key in combination with the underlined letter in the desired menu title. For
example, press ALT-F to pull down the File menu; then press U to upload a
file. Choosing any menu item that appears with an ellipsis after it (…) causes
a dialog box to appear. The ESC key will allow you to exit from any menu or
screen.
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CONFIGURATION

BUTTONS FOR FONTS

When clicked the Font Dialog box will appear, allowing you to choose a
different fixed pitch font with the option to change the font style. For further
information see Chapter 2 Font Configuration.
This will correct the font size for the window if Auto-size Font is not
selected. This is a one time basis and does not turn on Auto Size.

POINTER
The pointer changes shape depending on its position and the current activity.
While in the terminal screen area, the pointer is an arrow. Use it to position the
cursor at a specific character position, or to locate a starting position for text
that is to be copied or cut to the clipboard. When over the Function Keys, the
pointer changes to a hand. Position the hand over the key you wish to click and
“press”.

BUTTON

BAR

/ STATUS

BAR

The button bar consists of shortcut commands that are available from the pulldown menus. These buttons, and the items that appear in the status bar, are
user selected. For more information on these items, see Button bar and status
bar configuration in Chapter 2.
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USER-DEFINED

KEYS

The user-defined keys, F1 through F8, display along the bottom of the screen as
shown in the following dialog box. A label for each key appears in a box that
represents the key. The keys and labels are programmable (see Configuring
user-defined keys, later in this chapter).

To hide the user-defined keys:
1. Select Hide Function Keys from the Options menu.
2. To display the Function Keys reselect Hide Function Keys.

CONFIGURING

USER-DEFINED KEYS

To load the menu of user-defined function keys press F11. This command corresponds to the SHIFT-User System key combination on the 2392A and 700/92
terminals. User-defined keys can be set locally or programmatically. Default
label keys are F1 through F8.
Note: You must be logged onto the host system in order to program user-defined function keys.
To have WS92 start up with the user-defined keys visible:
1. Select Screen from the Config menu.
2. The Screen Configuration dialog box appears, select User as the FnKey
default setting.
3. Then click OK.
Note: Clicking OK activates your choices for the current session only. WS92
does not save any configuration changes permanently until you select Save or
Save As from the Config menu.
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To program user-defined keys:
1. From the Config menu select keyboard, then select HP Function Key. You
can also define VT Mode keys, see Emulating a DEC terminal later in
this chapter.
2. Using the tab key, move through the fields and position the cursor at the
function key you wish to program. The first programmable field for each
function key is the attribute field, which defaults to T.
3. Press F2 Next Choice or F3 Previous Choice to set the key’s attribute.
Attribute choices are as follows:
T (Transmit-only): In remote mode, WS92 transmits the user key string
and automatically transmits a carriage return. In local mode, this key has
no effect.
N (Normal keyboard input): This string is treated exactly as if it had been
entered from the keyboard. A carriage return is not automatically transmitted. If WS92 is in local mode, the string is displayed on the screen, and
embedded escape sequences are executed locally. In remote mode, with
local echo off, the string is transmitted to the host computer, and is executed and displayed only if the host system echoes.
L (Local-only): The user key string is executed locally but is not transmitted to the host system.
4. Press the tab key to move to the Label fields.
5. In the first Label field, enter up to eight characters as you wish them to
appear on the top line of the key’s label in the function key window. If the
label continues to the second line, add this text in the second field.
If your function key labels displays only one line, WS92 will display only
what you enter in the first Label field.
Note: When entering data into the label and definition fields, you can use
all the editing keys (INS, DEL, clear line, etc.) as if format mode were
active.
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6. Press the tab key to move to the program entry field.
7. Using no more than 80 characters, enter the exact character string the user
key is to generate. Include escape sequences and ASCII control codes
within the string by pressing F7 Display Functions before entering the
control codes. Disable display functions mode immediately after entering
the desired control code by pressing F7 again.
For example, enter a carriage return by pressing F7. Then press the Enter
key. A carriage return character appears. Press F7 again to turn Display
Functions off.
8. When you have finished defining the function keys, press F8 Exit Config.
The keys you defined should appear across the bottom of the screen, in the
function key window.
9. To save this set of user keys to the current configuration file, select Save
from the Config menu. To save this set of user keys to a new configuration
file, select Save As from the Config menu and enter a new file name (see
Saving a Configuration in Chapter 2).
10. If the user-defined keys are lost for any reason (for example, while running
a host application), press F11, or select Keyboard from the Config menu,
and select HP Function Key Strings. Then press F5 Restore Saved.Userdefined keys are restored to the values initially loaded by the user.

FUNCTION KEYS
The Function key scroll bar gives you access to the various sets of function
keys. In HP emulation mode if the appropriate keyboard mapping defaults have
not been changed, you may use the following:
F9 - toggles the function key display ON and OFF.
F10 - block-mode enter key.
F11 - displays user-defined keys.
F12 - refreshes the screen.
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To activate a key, press F1 through F8 on your keyboard or click the key with
the mouse pointer. An asterisk appears in the lower right corner of the key
when its function is activated.
Scroll through the hierarchy of function keys by using the function key scroll
bar or pressing CTRL-PgUp and CTRL-PgDn.
In VT emulation mode, the VT320 PF keys are displayed across the top of the
screen. For information on VT emulation mode, see Emulating a DEC terminal, later in this chapter. For information on configuring the button bar, see
Button bar and status bar configuration in Chapter 2.

MODES

KEYS

Modes keys control the mode of communication between the keyboard and the
host. Access the Modes keys from the menu of System function keys (see
System keys, in this chapter). To have WS92 start-up with the Modes keys
visible:
1. Select Screen from the Config menu.
2. The Screen Configuration dialog box appears, select Modes as the FnKey
default setting.
3. Then click OK.
To access the Modes keys, click the arrows for the function key scroll bar or
press CTRL-PgUp or CTRL-PgDn until the Modes keys are visible. The Modes
keys are as follows:

F1 - Line Modify: Corrects a line of text without having to retype the complete line. You may edit the line of text containing the cursor. This line is
transmitted to the host as a block when you press RETURN or ENTER.
F2 - Modify All: This mode is similar to Line Modify mode except it is not
deactivated by the RETURN or ENTER key. The block of text you edit is
transmitted to the host when you press F2 Modify All again.
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F3 - Block Mode: Toggles between Block Mode and Character Mode (Asterisk indicates Block Mode is ON). In Block Mode, the characters are not
sent to the host until you press RETURN, whereas in character mode,
each character is sent to the host as soon as the key is pressed.
F4 - Remote Mode: Toggles the terminal between Remote Mode and Local
Mode. (Asterisk indicates Remote Mode is ON.)
F5 - Type-ahead: Turns Type-ahead ON and OFF. Type-ahead allows you to
type characters before the HP host is ready to receive them. WS92 stores
the characters and transmits them when the host is ready. Notice the letter
T appears in the status bar when this option is ON.
Note: If you are connecting to an HP9000 or Unix machine, leave typeahead off.
F6 - Memory Lock: Turns Memory Lock ON and OFF. Memory Lock can be
used in Overflow Protect Mode or Display Lock Mode. Overflow Protect
prevents data loss due to memory overflow. Display Lock is used to lock
lines of text on the screen so it does not move using Roll Up or Roll Down.
F7 - Display Functions: Turns Display Functions ON and OFF. In this mode,
control characters and control codes are displayed as symbols on the screen.
You must use Win92 font to display the control code symbols correctly.
F8 - Auto Linefeed: Turns automatic line feed ON and OFF. Auto Linefeed
causes a line feed with every carriage return.
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DEVICE

CONTROL KEYS

The device control keys allow you to store a block of screen memory temporarily, in order to send it to a specified destination. To access the device control
keys, click the arrows in the function key scroll bar or press CTRL-PgUp or
CTRL-PgDn until F1 is the Device Control key; then press F:

F1 - Device Modes: Toggles between Device Mode and Device Control
keys.
F2 - Record Mode: Sends incoming data directly to the destination(s) specified by the device control keys.
F3 - Log Bottom: Sends data to the printer and/or disk file one line at a time as
it is received in display memory.
F4 - Log Top: Sends data to the printer and/or disk file a line at a time as it is
forced off the top of display memory.
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DEVICE

MODES KEYS

Device modes keys allow you to control how data is sent to the destination
specified by the device control keys. To access the device modes keys, press
F1 from the device control keys. The device modes keys, are as follows:

F1 - Device Control: Toggles between Device Modes keys and Device Control Keys.
F2 - To External Device: Selects the local printer as the destination device.
F3 - To Display: Selects the screen as the destination device.
F4 - Advance Page: Sends a form feed character to the printer.
F5 - Advance Line: Sends a line feed character to the printer.
F6 - Copy All: Copies all display memory, starting with the position of the
cursor to the last line of the screen and sends it to the device specified by
F2 or F3.
F7 - Copy Page: Copies display memory from the position of the cursor to the
last line of the screen and sends it to the device specified by F2 or F3.
F8 - Copy Line: Copies the line containing the cursor and sends it to the
device specified by F2 or F3.
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SYSTEM KEYS
Use the System function keys to access other menus of keys, such as Device
Control, Margins/Tabs/Col, and Modes keys. The System keys also allow you
to capture displayed text to a PC file or print a PC file on a host-based printer.
To access the System keys, click the arrows in the function key scroll bar or
press CTRL-PgUp or CTRL-PgDn until the System keys are visible. Keys
available are as follows:

F1 - Device Control: Displays the set of function key labels used to control
an external printer (see Device control keys, later in this chapter).
F2 - Margins/Tabs/Columns: Displays a set of function key labels used to
control margins, tabs, and column settings:
F1 - START COLUMN: Press this key to set the start column where the
cursor is for data transfers to the computer using labels LINE MODIFY
and MODIFY ALL.
F2 - SET TAB: Sets a tab stop in the column containing the cursor. Any
number of tabs can be set per line up to 79. The cursor can be moved to the
next tab stop by using the tab key.
F3 - CLEAR TAB: Clears the tab stop from the column containing the
cursor.
F4 - CLEAR ALL TABS: Clears all tab stops.
F5 - LEFT MARGIN: Sets the screen’s left margin in the column containing the cursor.
F6 - RIGHT MARGIN: Sets the screen’s right margin in the column containing the cursor.
F7 - CLEAR ALL MARGINS: Clears all margins set by the user. The left
margin is reset to column 1 and the right margin is reset to column 80.
Notes: A CTRL +PgUp or PgDn will return you to the system keys.
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F4 - Modes: Displays the set of function key labels used to control operating
modes. The Modes function key can also be accessed from the System
keys.
F5 - Capture to Disk: Directs everything that displays on the screen to a disk
file on your PC.
F7 - Print to Host: Directs any PC disk file to a host-based printer for printing.

OPENING

AND CLOSING A SESSION

Open and close a session on the host computer just as you would from a terminal: logging on and off the host.
To logon:
1. Start WS92 and configure a connection.
2. Press RETURN and wait a moment for a system prompt from the host.
3. If no system prompt appears, check the configuration settings discussed in
Chapter 1 and 2, and make any necessary adjustments; then, press RETURN. Make one adjustment at a time (for example: change the handshaking, then change the baud rate for a serial connection; or change the
network driver, then the IP address for a network connection), until you get
a system prompt from the host.
4. At the system prompt, type your usual log-on.
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When exiting WS92 be sure to log off the host before exiting. To log off and
exit, we suggest one of the following ways:
1. At the system prompt, type your log-off, usually BYE or EXIT.
2. From the File menu, select Exit (ALT-F4).
3. Select Exit from the Off Line dialog box.
4. Click the

at the far right of the title bar.

Reminder: WS92 does not save any configuration changes permanently until
you select Save or Save As from the Config menu.

NEED

FURTHER INFORMATION....

Chapter 2
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MANIPULATING

TEXT

To manipulate text on the display, use the commands from the Edit menu to
copy and paste blocks of text, delete and insert lines, clear text from the current
line or entire screen.

COPY

AND PASTE

WS92 allows you to copy and paste from the Windows clipboard.
Copy a block of text from WS92 display in one of the following ways:
1. Select a block of text by positioning the mouse pointer in one corner of the
area you wish to select and:
♦

drag the mouse diagonally to the opposite corner (for example, from
upper left to lower right). If the text you wish to select extends beyond
the display area, drag the mouse toward the boundary, and the window
scrolls to make the selection.

♦

press SHIFT with the appropriate arrow key(s) to select text characterby-character and line-by-line. You can also press SHIFT HOME or END
to select all text in the document.

2. Select Copy Selection from the Edit menu (CTRL-INS). Note that CNTL
C can be remapped to Map to Action: Copy Selected.

NEED

FURTHER INFORMATION....

Chapter 2
Chapter 7
Chapter 7
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Capture to Disk
Print to Host
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To copy the entire contents of display memory:
1. Select Copy All from the Edit menu (ALT-A). Everything currently in
display memory is copied to the clipboard. You can increase or decrease
the amount of display memory by configuring the number of screen pages
in the Screen Configuration dialog box (see Chapter 2).
Note: If the clipboard is empty or contains something other than text, the
Paste command is disabled (grayed out).
To paste text in the display area:
1. Position the cursor on the point at which you wish to paste the text.
2. Select Paste from the Edit menu (SHIFT-INS). Note that CNTL V can be
remapped to Map to Action: Paste. Text currently in the Windows clipboard is pasted to the screen.
Note: If right mouse button is configured to paste, the right mouse button
can be used to do both, copy selection or paste. If no data is selected the
right mouse button will paste from the clipboard. (See Special Configuration in Chapter 2).

MINISOFT 92

3-17

CHAPTER 3: RUNNING A HOST SESSION

DELETE

AND INSERT LINES

To delete a line of text from the display:
1. Position the cursor in the line of text to be deleted.
2. Select Delete Line (ALT-D) from the Edit menu. The line disappears, and
subsequent lines scroll up one line to take the place of the deleted line.
To insert a line of text:
1. Position the cursor on the line below to allow a blank line to be inserted
above.
2. Select Insert Line from the Edit menu (ALT-I).
3. A blank line appears above the line where the cursor is located. The Line in
which the cursor is located and all subsequent lines scroll down one line,
and the cursor moves to the left margin of the inserted line.
4. Type text on the new blank line.
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CLEARING

TEXT

Clearing a line or display differs from deleting, in that text below the erased line
does not scroll up to replace the deleted text; the line remains blank.
To clear a line:
1. Position the cursor in the line of text to be cleared.
2. Select Clear Line from the Edit menu (ALT-K). The line is erased, and the
cursor moves to the left margin of the blank line.
To clear the display:
1. Position the cursor in the area to be erased.
2. Select Clear Display from the Edit menu (ALT-J). Everything from the
current cursor position to the end of display memory is erased from the
screen.
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GETTING

HELP

The Help menu provides information about the version of WS92.
About WS92 for Windows
Displays the version number of WS92. After clicking OK, press SHIFT +
ALT + X simultaneously to display a Debug dialog box with the subversion
number.
Keyboard help in WS92
Displays a list of keyboard equivalents for commonly used actions in WS92:

Script language in WS92
See the Script Language manual for further information.
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EMULATING

A DEC TERMINAL

Emulating a DEC terminal enables you to run VT applications and display data
in ANSI. ANSI is a common mode for dial-in bulletin boards and modem connections.
When selecting a VT terminal type, choose VT220 or VT320 for connections
to VAX and Unix systems. Use VT100 when dialing into bulletin boards that
require ANSI support.
When running WS92 in VT mode, selecting Ansi Color from the Config menu
allows you to configure the color specifically designed for VT terminals. In
addition, function keys appear at the top of the screen.

NEED

FURTHER INFORMATION....

Chapter 2
Chapter 3
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VT Terminal Option
VT Status Bar Configuration
VT Keyboard Mapping
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To configure DEC emulation:
1. From the Config menu select Emulation. Select VT52, VT100, VT220, or
VT320.
2. If you have not already mapped your VT keys the VT Key Mapping dialog
box appears. If you do not wish to remap these keys select Defaults and
then Done.
3. Save your configuration.
4. If you change the setting during a session, WS92 resets the function keys
and runs the new setting.
5. To change back to HP mode, you must select Emulation from the Config
menu, then select HP.
If you have activated the Emulation Type option in the Configure Status Bar
box, WS92 displays the emulation setting in the status bar at the bottom of the
screen (for example, “EM220” for VT220 mode).
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TERMINAL

CONFIGURATION IN

VT

MODE

When you select Terminal from the Configuration menu while running WS92 in
VT mode, the options available for configuring the terminal are specific to VT.
To configure terminal options for VT mode:
1. Select Terminal from the Config menu. The Terminal Configuration dialog
box appears:

2. Configure the following settings:
AutoWrap at End of Line: Enables line wrapping automatically. Default
leaves this option disabled, causing a hard line break at the end of each line.
HP Function Keys: Default is disabled. Displays the HP function keys
across the bottom of the screen while in VT mode. Use this option for HP
applications that operate in EM220 mode, such as UDMS and Oracle.
These applications, while requiring VT220 screen display, still use the HP
terminal F1 through F8 keys.
Support 8-bit controls: If you are having problems with DEC terminal
screen display, select this option and try again.
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Keypad: Default is Numeric. Selecting Numeric uses the PC keyboards
numeric keypad. Selecting Application uses the host application’s keypad
configuration.
Cursor Keys: Default is Normal. Selecting Normal uses the PC keyboard’s
conventional configuration. Selecting Application uses the host application’s
cursor key configuration.
3. For default settings, click Default.
4. When you have finished customizing the settings, click OK.
Note: Selecting OK activates your choices for just the current session.
WS92 does not save any configuration changes permanently until you select Save or Save As from the Config menu.

CONFIGURING

THE STATUS BAR IN

VT

MODE

Status bar items are specific to the capabilities of the VT terminal. Configure
the Status bar only when you select Bars from the Config menu while running
in VT mode.
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MAPPING VT

KEYS

DEC terminals contain keys that do not exist on a PC keyboard. To configure
your PC keys to map DEC VT220 or VT320 functions, select Keyboard >
Mapping from the Config menu.
To define VT keys:
1. Select Keyboard > Mapping from the Config menu. The VT Key Mapping dialog box appears:

2. Click Defaults to activate the default keyboard mapping or customize your
keyboard mapping using the instructions given in Chapter 2 under the heading Keyboard Mapping.
3. When you have finished mapping the keys, click Done.
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Default settings for VT key Mapping are as follows:
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VT220 Key

PC Function Key

Find
Insert Here
Remove
Select
Prev Screen
Next Screen
Backspace
PF1
PF2
PF3
PF4
F6 through F10
F11 through F20
,
-

CTRL-F
Ins
Del
CTRL-P
Page Up
Page Down
Backspace
NumLock
/
*
F6 through F10
SHIFT-F1 through SHIFT-F10
CTRL-+
CTRL—
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DIRECT

SERIAL CONNECTION

A serial connection between MS92 and the host computer requires a direct
cable between the PC and host. Similar to making a serial connection,
connecting via modem requires data communications configured to match the
host computer’s modem.
To configure WS92 for a serial connection:
1. Run WS92.
2. Select Comms and Network from the Config menu.
3. From the Connection Type dialog box, select Serial. The Serial Communications Parameters dialog box appears:
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Options Available:
Baud Rate: The speed at which telecommunicated data is transmitted.
Measured in bits per second. Select a setting that matches your host
computer.
Parity: An error checking mechanism for the transmission of data.
Default is None for most host computers. Select None when installing
the host file transfer program (WS92LINK) to the HP e3000 (For
further information see Chapter 6).
Data Bits: Units of data. Default for most host computers is eight.
Select eight when installing the host file transfer program (WS92LINK)
to the HP e3000 (For further information see Chapter 6).
Handshaking: The procedures and standards (protocol) used by two
computers or a computer and a peripheral device to establish communication. MPE/iX users should select Receive Xon/Xoff and Xmit Xon/
Xoff handshaking options.
Port: WS92 supports serial communications through COM1, COM2,
COM3, and COM4. If you have configured a different port other than
the ones described above, select Specify and name your valid port name
in the ‘Port Name’ field.
4. For a configuration of default settings, click Default Values.
5. Modify the default settings as desired. When you have finished customizing the settings, click OK. Selecting OK activates your choices for just
the current session. MS92 does not save any configuration changes
permanently until you select Save or Save As from the Config menu.
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WS92

MODEM CONNECTION

MS92 provides support for any Hayes-compatible modem.
To dial a remote host computer via MS92:
1. Run WS92, and configure for a serial connection. Set the baud rate,
parity, etc., to be compatible with the settings of the host computer’s
modem.
2. At the Cursor, type:
ATZ

The modem responds: OK
3. Type ATDT and the telephone number of the modem you are dialing.
ATDT 15551212

4. Press RETURN. As the modem dials, you will hear a modem tone and
then see the message CONNECT 2400 on your screen (this message
may or may not match your baud rate on your computer).
5. Press RETURN to receive a prompt from the remote computer.
If the host prompt does not display, check to see that the correct baud rate
and com port have been specified. Also, try resetting your modem with the
command ATZ (resets most modems) or AT&F (resets most modems back to
their factory defaults).
MS92 includes a command language that can be used to automate this
procedure. The command language is especially useful when you are
repeatedly dialing the same modem number.
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Note: Some WinModems do not talk to a host modem but are designed to use
the dial-up network adaptor. To get a WinModem to talk to a Host modem
may take changes to the modem settings - some WinModems WILL NOT
communicate over a serial (COM Port) connection. Please try the following
steps below if you are having difficulty with your modem.
1. From the Windows Control Panel, open Modems (Phones and Modems
Options for Win2000 users).
2. Highlight the Modem you are using, then click Properties.
3. Take note of the port the Modem is using.
4. Select the Connection Tab, and then click Advanced.
5. Select Use Error Control, Required to Connect, Compress Data, Use
Flow Control and Hardware (rts/cts). Then click OK.
6. From the Connection Tab, click Port Settings.
7. Select Use FIFO Buffers and, move the Receive Buffer to Low (1),
then click OK.
8. Select the General Tab. Set the Maximum speed to 9600 and click OK.
Then close the Modem dialog box.
9. At the cursor prompt in WS92, type:
AT&F&K3DT (PHONE NUMBER YOU ARE TRYING TO CONNECT TO)
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WS92

MODEM DIALER

The WS92 modem dialer supports Hayes-compatible internal and external
modems.
1. From the Config menu, select Dialing List. First time users will see the
following message: DIAL92 file not found: will create new one. Click
OK.
2. The Dialing List dialog box appears:

3. Enter the appropriate Prefix, default is ATDT.
4. Then click ADD. Insert the name, phone number, and baud rate. When
finished click OK, the entry is shown to the right.
5. When you have finished adding the needed entries, click Save List.
6. To dial a number on the Dialing List, select Dial from the Options menu.
Select the appropriate entry, and click Dial Now.
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Note: The Modem Dialer can only support a phone number up to 13 digits.
For longer numbers, select Special > Long Phone Numbers from the
Config menu. This will create a new file called Ldail.92 that holds sets of
numbers up to 35 digits. A script can also be used to dial numbers (see
Sample Script in the Help file).
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WINSOCK

REQUIREMENTS

Certain software components are required on the PC and the host computer in order to connect your PC to a host computer via WinSock.

WINSOCK

PC REQUIREMENTS

The following desktop operating systems are supported:
♦

Windows 95/98/ME

♦

Windows NT 4.0 and Windows 2000

Windows comes with its own TCP/IP protocol stack, which you can install
and configure manually. To install the TCP/IP protocol stack check with
your network Administrator or contact Minisoft support for any questions.

NEED

FURTHER INFORMATION....

Windows On-Line Help
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HOST

REQUIREMENTS

Host server software is also required for the HP e3000, HP9000, or Unix
system according to the host protocol, Telnet or NS/VT.

TELNET
For Telnet connections, you must have a software package called ARPA
Services. ARPA Services is available for both the HP9000 and HP e3000.
Most Unix systems come with the Telnet protocol bundled with their operating system.

NS/VT
For NS/VT connections (Network Services), check to make sure VT (Virtual Terminal) and VTA (Virtual Terminal Access) are running, and Ethernet
II frame type has been enabled on the host computer.
To verify and run VT (incoming virtual terminal) and VTA (incoming
stream mode virtual terminal) services:
1. Verify that the services have been started.
2. Logon as system manager.
3. At the system prompt, type:
NSCONTROL STATUS=SERVICES

and press RETURN.
4. The STARTED column for VT and VTA should indicate YES.
5. If not, start VT and VTA by typing the following:
NSCONTROL START=VT,VTA

and press RETURN.
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To verify and enable the Ethernet II frame type:
1. Logon to the host as system manager, and run NMMGR by typing:
RUN NMMGR.PUB.SYS

2. Press the Open Config key, then press the NS key to open the NS Configuration screen.
3. Press the Guided Config key, then the Config Network key to display
the configuration screen for your network.
4. If Enable Ethernet is set to N, specify Y.
5. Press Save Data, and exit from NMMGR.

CONFIGURING

THE WINSOCK CONNECTION

If you already have the WinSock-compliant TCP/IP protocol stacks installed, configure a WinSock connection as follows:
1. Run WS92, and select Comms and Network from the Config menu.
2. The Communications Type dialog box appears:

3. Select Telnet or NS/VT (Network Services) as the virtual terminal protocol.
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3. Selecting Telnet causes the following dialog box to appear:

Selecting NS/VT causes the following dialog box to appear:

4. Enter the name or IP address of the host computer; for example:
164.231.9.17.

5. If the configuration is via Telnet do the following:
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♦

Default Port number is 23. Only in rare cases with a few communications servers will you need to enter a different port number.

♦

If your Terminal ID is required, enter a valid Terminal ID in the
‘Terminal ID’ field.

♦

Select Xmit NULL after CR, only if connecting to an HP e3000.
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6. If the connection is via NS/VT:

Enter the local name, domain, and organization of your PC (run
NMMGR and press the Open Config key to determine the domain and
organization). This field is optional—fill it in if you wish to have a
NSCONTROL STATUS=USERS command to display the user’s session name. If you leave this field blank, the user will be listed as $Back.
7. When the settings are configured as desired, click OK. The connection
is established.
8. From the Config menu Select Save.
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FILE

MINISOFT 92

TRANSFER PROTOCOLS

♦

WS92LINK - Minisoft proprietary protocol for transferring files to and
from HP e3000s over serial or network connections. If you use this
protocol, you must install the host link program on your host computer. For installation instructions see the following heading in this
chapter, Uploading WS92LINK to the Host.

♦

Network File Transfer (NFT) - Minisoft’s utility for transferring files
across the network. Unlike Minisoft’s proprietary WS92LINK, which
operates within WS92, NFT is a stand-alone product that requires a
network connection. You do not have to be running WS92 in order to
use NFT. (See Network File Transfer (NFT) in Chapter 6).

♦

Xmodem - A common protocol for transferring files to and from bulletin boards and Unix systems. If you use this protocol, there is no additional Minisoft software to install on your PC. However, BBS, Unix
systems, or HP e3000 hosts must have the Xmodem protocol installed
in order for it to transfer files (HP9000 comes with an Xmodem called
“Umodem” already installed).
P r o to c o l

P C system

Host

WS92LINK

Windows

HP 3000;
MP E/iX only, not MP E-V

Network File Transfer (NFT Windows
and FTP )

HP e3000, HP 9000, Unix
network connection only

Xmodem

BBS
Unix
HP 9000

Windows
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WS92LINK
WS92 uses WS92LINK, its own Minisoft proprietary protocol, to transfer
files to and from an HP e3000 by a serial or network connection.
Note: If the connection is serial, set parity/data bits to None/8 in order to
install the host program (see Direct Serial connection in Chapter 4, for
data communication settings).

CONFIGURING

WS92LINK

To configure WS92LINK:
1. Run WS92.
2. Select File Transfer from the Config menu. The File Transfer Configuration dialog box appears.
The settings you define in the File Transfer Configuration dialog box
determines your global file transfer configuration. You may adjust these
settings as needed to affect file transfers temporarily, for the duration
of the current session.
3. Configure the following settings. For a configuration of default settings, click Defaults.
4. When you have finished configuring your settings, click OK. Clicking
OK activates your choices for the current session only. WS92 does not
save any configuration changes permanently until you select Save or
Save As from the Config menu.
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Options Available:
Protocol: Select Minisoft to use Minisoft’s proprietary file transfer protocol; select Xmodem 128 or Xmodem 1K, depending on the copy of
Xmodem you are running when using the Xmodem protocol; select
NFT to use Minisoft’s utility for transferring files accross the network.
Minisoft Protocol Options
Add trailing spaces: Select this option if you wish to keep spaces at the
ends of lines (spacebar characters).
Timeout: Length of time in seconds that WS92 waits for data from the
host before assuming the item has been lost. The number of seconds
should be increased if the host is known to be slow.
Default Record Size: Number of bytes per record; use on uploads only.
Default bytes per record is 80.
General Options
Default to ASCII: If this option is enabled, files will be transferred in
ASCII mode unless the binary mode is selected during a file transfer.
Ctrl Z for End of File: Sends the CTRL-Z character at the end of an
ASCII file.
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List Host Files: Allows you to view the files in the group you logged
onto.
Strip Carriage Control: Strips the carriage control character from the
first position of a record, when file is downloaded as an ASCII file and
the Host file has a file code of VAC or FAC selected.
Suppress Run Command: The RUN command will not be inserted in
the Host Program Name field, which is shown toward the bottom of
the File Transfer Configuration dialog box. The host program file will
therefore not automatically be run. Instead, you will have to manually
enter the RUN command at the beginning of the file. Required for
Xmodem transfer.
This option allows you to run the Host Program file when you are not at
the prompt or in an application that may not require a RUN command.
Spaces per tab: Enter the number of spacebar characters to replace a
tab character in the file being transferred.
If File Exists: If a file with the same name as the file being transferred
already exists on the receiving computer, you have the following options:
Overwrite: Overwrites the existing file with the contents of the file
being transferred.
Append: Appends the contents of the file being transferred to the end
of the existing file.
Cancel: Cancels the transfer of the file.
Host Program Name: WS92LINK.group.account; default is
WS92LINK.PUB.SYS. WS92 returns an error message, Could Not
Connect to Host, if the host program could not be found or the location
for the host program was specified incorrectly.
Host Printer Name: This field is optional. Enter the device name or device
number of your host printer, such as LP/S or 66/S. WS92’s Print File
to Host Printer feature uses this field (see Chapter 7). If the host printer
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is connected serially, add /s to the device name or number. If the host
printer is a parallel device (line printer), do not add /s.
Note: If you wish to print to a file on the host rather than on a printer,
enter DISC in the Host Printer Name field. On the host, the file will be
called MWLIST.

UPLOADING

WS92LINK TO THE HOST

To upload WS92LINK:
1. At the host computer, logon as MANAGER.SYS.
2. By default WS92LINK installs in PUB.SYS. You must have write and
save access.
3. Once you have configured the File Transfer Configuration window
press Upload Host Program. When pressed, you will be prompted with
the following:

NOTE....
WS92LINK can transfer large blocks of data without a change in configuration.
WS92LINK automatically uses data compression if the connection is serial; compression is not used over a network connection.
WS92LINK performs its own test to see whether expanded control characters are
needed, and automatically enables these settings if they are.
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4. Select Yes and the File Transfer status window appears:

5. Verify the WS92LINK program has been accepted or uploaded to your
Host by typing the following at the system prompt:
VERSION WS92LINK.PUB.SYS

6. Press RETURN. The following message will appear if the host program has been uploaded successfully:
WS92LINK - 2.0.5.7

The version number 2.0.5.7 is subject to change when changes have
been made and a new version is applied.
Note: The WS92Link needs to be uploaded only once for each HP
e3000 Host.
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DOWNLOADING

A FILE

To download a file from your host computer to your PC or workstation:
1. From the File menu, select Download File from Host. The following
dialog box appears.

2. Enter a file name for the local PC file, and specify the HP file name to
be downloaded in the MPE File field.
If needed you may override any of the default settings.
3. Click START. The host file is transferred to your PC according to your
specifications.
Required Options:
MPE File: Name of the file on the host that is to be downloaded.
File Name: Name of the PC file. From the Directories tree, select the appropriate directory the file will be put in.
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Available Options:
Save file info: Saves the file information in the first 128 bytes of the destination file. This option is useful if you are transferring a file from one
minicomputer/host to another via a PC. If you save file information,
then the file on the destination minicomputer/host will have the same
file attributes (record size, block size, etc.) as the original file. Some
emulators refer to this as label file transfer.
If File Exists: If the receiving file you specified already exits on your PC,
select one of the following options:
Overwrite - Replaces the existing file with the downloaded file.
Append - Attaches the downloaded file to the end of the existing file.
Cancel - Preserves the existing file and cancels the file transfer.
Type: Select ASCII for a character-based file; Binary for a binary image of
the file being transferred, no CRLF will be added to the PC file.
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UPLOADING

A FILE

To transfer a file from the PC to the host computer:
1. Select Upload File to Host from the File menu. The following dialog
box appears:

2. Under File Name, specify the local PC file to upload. Under MPE File
Name, specify the name of the file on the Host.
3. If needed, override any of the default settings.
4. Then click START. The PC file will be transferred to your Host according to your specifications.
Available Options:
Save file info: Saves the file information in the first 128 bytes of the destination file. This option is useful if you are transferring a file from one
minicomputer/host to another via a PC. If you save file information,
then the file on the destination minicomputer/host will have the same
file attributes (record size, block size, etc.) as the original file. Some
emulators refer to this as label file transfer.
Record Size: Must include record size.
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If File Exists: If the receiving file you specified already exits on your PC,
select one of the following options:
Overwrite - Replaces the existing file with the downloaded file.
Append - Attaches the downloaded file to the end of the existing file.
Cancel - Preserves the existing file and cancels the file transfer.
Type: Select ASCII for a character-based file; Binary for a binary image of
the file being transferred, no CRLF will be added to the PC file.
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UPLOADING

LARGE

ASCII

FILES

WS92LINK version 2.0.5.6 supports large ASCII file transfers, prior versions of the host link require you to create a file equation at the system
prompt.
1. To determine the version of WS92LINK on your host, type the following at your system console:
VERSION WS92LINK.PUB, SYS

2. Press RETURN. The following message will appear, specifying the
version number, such as:
WS92LINK.PUB.SYS - 2.0.5.7

3. If the host file version is prior to 2.0.5.6, upload the newest WS92LINK
(refer to Upload WS92LINK to host in WS92 previously in this chapter).
4. If you do not run the 2.0.5.6 version of WS92LINK, you must create a
file equation at the system prompt. Type:
FILE filename; DISC=# of records

where # of records is equal to the number of lines in the file. For example, if a file has 60,000 lines, enter DISC=60000.
If a file equation is used, then an * must proceed the file name in the
remote filename. Without the * the file equation is not used.

NEED
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Appendix F

NFT’s OLE Automation Interface

README.TXT

Installation procedures for NFT ( \Minisoft\UTILS folder )
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NETWORK

FILE TRANSFER

Minisoft’s Network File Transfer program is contained on the MS92 distribution CD. Those who purchase MS92 also receive NFT. Installation
of Network File Transfer is a two-step process, Client and Server. All
other Servers should have FTP already installed. NFT requires Windows,
and a WinSock-compliant server TCP/IP stack. It runs on MPE/XL or
MPE/iX.

INSTALLING

THE NETWORK FILE TRANSFER

The Client portion of the Network File Transfer is installed automatically
when selecting NFT_PC_SETUP.exe. It will install in the C:\Minisoft\Utils
folder by default.
Note: NFT uses client/server technology to transfer files between your
PC and the HP e3000 host. The software installed on your PC is the client
portion; you must install the server portion on the HP e3000.

INSTALLING

NFT ON THE

HP E3000.

Install the Server Utility by running NFTSETUP.exe from windows and
following the on screen instructions. The Server Installation Utility will
create the default Account, User and Group needed for NFT on the HP
e3000.
The server portion must be installed by transferring the server programs
to the HP e3000, and then running the server in a JOB stream.
Note: In order to have extended characters converted correctly between
Window ANSI and HP-ROMAN9 when using NFT see Chapter 2 Using
Translation Tables with NFT.
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OPERATING

NFT ON THE

HP E3000.

After the server programs have been uploaded to the HP e3000, the Network File Transfer server is started by streaming the following command.
This JOB must be running for Network File Transfer to operate:
:STREAM NFTJOB.MM.MINISOFT

To disable the Network File Transfer, abort the JOB from the console.
Streaming NFTJOB.NFT.MINISOFT should become part of your normal
system start-up procedures.
The file NFTJOB.NFT.MINISOFT contains the following:
!JOB FTJOB,MGR.MINISOFT,MM;OUTCLASS=LP,1
!RUN SERVER.MM.MINISOFT;PARM=512;INFO=”30001
NFTSRVR.MM.MINISOFT”
!EOJ

If you wish to change the location of the server programs from
NFT.MINISOFT to a different group and account, then you must change
the group and account names in the above JOB file.
The first parameter in the INFO string above contains a TCP/IP port number. This is any number between 1 and 32767. Each server using TCP/IP
must have a unique port number. We recommend using 31001, since we
have not found any other software on the HP e3000 that uses this number.
All clients must set this same port number in their configuration in order to
connect to the server program.
If you wish to have more than one server active, then each server must
have its own unique port number. Remember that one server can service
any number of clients simultaneously, so only one active server is required.
You may, however, wish to have more than one server for accounting or
security reasons.

MINISOFT 92
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AUTOMATING NFT
Use Visual Basic or Visual C++ to automate the use of NFT.
NFT objects are used by the NFT client to communicate with a file server
program on the host. This gives NFT the ability to transfer files to and
from the host as well as execute MPE commands, MPE command files,
and programs.
In order to access the NFT server software, the client program must create
the NFT client Session object, as follows:
Visual Basic:
Dim FTSession As Object
...
Set FTSession = CreateObject(“NetFT.Session”)

Visual C++:
CreateDispatch( “NetFT.Session” );

When the client program wishes to stop using the NFT server, you must
delete the Session object as follows:
Visual Basic:
Set FTSession = Nothing

Visual C++:
ReleaseDispatch();

NEED

FURTHER INFORMATION....

Appendix F
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RUNNING NFT
Network File Transfer uses WinSock technology to transfer files across
the network between your PC and an HP e3000 host. The host computer
must be running the MPE/iX or MPE/XL operating system.
To run Network File Transfer:
1. Double click the Network File Transfer icon:

.

NFT’s Connection Configuration dialog box appears:

Note: See Appendix F, for references to NFT’s FTP module. The NFT protocol is used to
communicate with the HP e3000; FTP communicates with the other host types listed in the
paragraph above. In this manual, both protocols are called NFT.
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2. The drop down Host Type box lists these available types: HP e3000
(MS NFT), Unix, IBM VM, VMS/Multinet, VMS/UCX, FTP’s PCTCP,
CUTCP/NCSA, NOS/KA9Q, WinQVT/Net, IBMPC TCP/IP, Chameleon, SuperTCP, SI NT/FTPD, IBM MVS, Unisys 5000, MPEiX Posix,
and SunOS.
3. Enter the host computer’s IP address and click OK.
4. Enter the required logon and password names.
5. Once connected to the host, use Network File Transfer to upload and
download files to and from the host computer.
NFT has the same data-compression capabilities that are featured in
WS92LINK.

6-18

MINISOFT 92

CHAPTER 6: FILE TRANSFER IN WS92

UPLOADING

A FILE

To upload a file:
1. From the Local File list box, select a PC file. If necessary, use the
directory tree to navigate to the file.
2. In the Host File text box, enter the name of the file to be uploaded.
If you wish to upload a file somewhere other than your logon group
and account, highlight the group and/or account name in the Group
and Account text box. Enter the desired name. Then click the Host File
text box and enter the file name. The list of host files is updated to the
new group and account.
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For Transferring files as ASCII characters, select the following options:

Control Z as EOF: Causes the CTRL-Z character to be interpreted as
an end-of-file marker.
Keep Spaces: Causes lines to be padded with spaces.
Spaces per Tab: Select a number of spacebar characters to be used to
replace a tab character in the file. A value of 0 does not replace tab
characters.
Record Size: Default is 80 bytes.
For Transferring files as Binary, select the following options:

6-20

MINISOFT 92

CHAPTER 6: FILE TRANSFER IN WS92

Save Info: Saves information such as record and block size in the first
128 bytes of the destination file. This choice is useful if you are transferring a file from one host to another via a PC.
Record Size: Default is 256 bytes.
3. For ASCII or Binary transfers select one of the following options if the
file already exists on the host:
Cancel: Cancels the file transfer.

Purge: Writes over the existing host file with the file being transferred.
Append: Attaches the file being transferred to the end of the existing
file.
Ask: Causes Network File Transfer to prompt the following:

5. Click the right-pointing arrow

to upload the file to the host.

NFT’s File Transfer Status box informs you of the transfer’s progress:
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DOWNLOADING

A FILE

To download a file using NFT:
1. Select a host file. If necessary, enter a different group and account
name.
2. In the Local File text box enter the file name to be used on the PC. If
necessary, navigate to a different path by clicking the directory tree.
3. Select transfer mode.
On downloads, the Use Control as EOF option writes a CTRL-Z character to the end of the file if the option is enabled.
4. Select the course Network File Transfer should take when the destination file already exists on your PC.
See Uploading a file with NFT, above, for further information on these
options.
5. Click the left-pointing arrow

CONFIGURING

to download the file from the host.

YOUR LOGIN

To change the default login:
1. Select Connection from the Configuration menu. NFT’s Connection
Configuration dialog box appears.
2. Depending on your Host Type, replace user, group, account, and/or
job name with necessary passwords.
3. Click OK and the list of available host files changes to reflect the new
login.
4. Select Save or Save As from the Configuration menu to make the new
login the default login the next time you run Network File Transfer
with this configuration.
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PRINTING CONFIGURATIONS
MS92 allows these printing options:
♦

Host to local printer.

♦

Host to a file on your PC

♦

PC to host-based printer.

Before printing from MS92, make sure the printer has been configured properly
in MS92. When printing host data on a printer attached to a PC, check the
configuration of the local printer. When printing from a PC to a printer attached
to the host computer, check the configuration of the host printer.

PRINTER

SETUP

To configure the printer when using windows default as your print driver:
1. Select Printer from the Config menu. Click Windows Default from the
Printer Configuration dialog box and then select Printer Setup.
The Printer Setup dialog box appears. The dialog box that you see may
differ from the example below, according to your active print driver.
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2. Configure the following options for your printer. This is a general description of options that may appear:
Default/Specific Printer: Select an available printer from the list of printers attached to your computer.
Paper Size: Specifies the size of paper you wish to use. Select custom if
you wish to use a nonstandard size paper.
Paper Source: Specifies where the paper you wish to use is located in the
printer. Different printer models support different paper sources, such as
upper tray, manual feed, and continuous feed.
Orientation: Specifies the document position when printed.
Fonts: If the dialog box has a Fonts option, additional fonts are available in
either font cartridges or downloadable soft font files supplied by the printer
vendor.
Options: If available, select unique options for your printer.
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LOCAL

PRINTER

In WS92, configure the local printer by selecting Printer from the Config menu.
The Printer Configuration dialog box displays. By default, Pass Through Printing is selected, Figure 7-1 will display. If Windows Default is selected, Figure 72 displays.
Figure 7-1

Figure 7-2
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Available Options:
Print Driver:
a. Windows Default: Uses the Windows default print driver. To use this
you must select the current font size from your printer. See Printer Setup.
b. Pass Through Printing: Minisoft’s recommended print driver. Uses the
Windows print driver to send all data including escape sequences to the
printer. Selecting this option allows the host application to control the printer.
Printer Selection:
Use Default Printer:
Windows Default: Data you select for printing will automatically be printed
on the default printer, as specified in the Print Setup dialog box. You will
not be prompted to select a printer.
Pass Through Printing: Allows different configuration files to have different default printers. The printer selected at configuration will be the default printer. You will not be prompted to select a printer.
Ask First Time: If this option is selected, the first time you issue a print
command in each WS92 session, the Print Setup dialog box will display.
Ask Every Time: If this option is selected, the Print Setup box will appear
every time you issue a print command.
Printer Init: When Pass Through Printing is selected as the print driver a
string is prefixed to the data being sent to the printer.
Printer Reset: When Pass Though Printing is selected as the print driver a
string is sent to the printer prior to closing the port.

NEED

FURTHER INFORMATION....

Chapter 6
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Timeout: Length of time, in seconds, to wait for data until the spool file is
automatically closed.
Suppress Automatic Spooling: Spoolfile will not close—regardless of the
timeout value selected in the previous option. You must select Close Print
Job from the Print menu in order to send data to the printer.
Suppress Form Feed on Close Printer: Option available for tractor feed dot
matrix printers. Has no effect on LaserJet printers.
Printer Setup: Option available under Windows default. Allows you the option
to change the current Windows printer.
Printer Font: Allows you to view and change available fonts under the Windows default.
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PRINTER

FONTS WHEN USING WINDOWS DEFAULT

If you are printing via Windows Print Manager, specify the font WS92 will use
for local output to a slaved printer.
This command allows you to select printer fonts that will allow 132-character
output. Choose a small font size, such as 8 or 9 point, to fit 132 column display
output on 8 1/2 by 11 inch paper.
To configure printer fonts when using windows default as the print driver:
1. Select Config, Printer from the menu bar. Select Windows Default from
the Printer Configuration dialog box, then select Printer Font.
The Font dialog box appears:

2. Select the desired font, font style, and size.
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SENDING
HOST

HOST DATA TO A LOCAL PRINTER

PRINTER

In WS92, select Host Printer in the File Transfer Configuration dialog box.
MS92 allows several ways of printing data from the host computer to a printer
attached to a PC:
♦

Send data to the printer as the display scrolls.

♦

Record data as it is received.

♦

Copy data from the display.

LOGGING

TOP AND BOTTOM

Sending data to the printer as the display scrolls depending on whether the data
is being sent from the beginning or the end of the scrolling region is called Log
Top or Log Bottom.

LOG

TOP

WS92 Menus
To use Log Top from WS92 pull-down menus:
1. Select Log Top from the Print menu. A checkmark appears next to the
command, indicating that Log Top is active.
2. Continue your host session. WS92 sends data to the printer as it scrolls off
the top of memory.
3. When the data you want to print has scrolled off the top, select Log Top
again. The checkmark disappears, indicating that Log Top has been disabled.
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4. To flush any remaining data from the printer select Advance Page from
the Print menu to send a form feed command to the printer. The printer
prints any remaining data.
Note: If you are printing through Windows Print Manager, select Close
Print Job instead of Advance Page from the Print menu to send an endof-file form feed to the printer so that a print process can begin (see Special configuration in Chapter 2).
WS92 function keys
Log Top using the HP function keys:
1. To access the system keys, use the function key scroll bar in WS92.
2. Press F1 Device Control.
3. From the Device Control keys, press F2 To External Device. An asterisk
appears in the function key label, indicating that the external device is active.
4. Press F1 Device Modes.
5. From the Device Modes keys, press F4 Log Top. An asterisk appears in
the function key label, indicating that Log Top is enabled.
6. Continue your host session. MS92 sends data to the printer as it scrolls off
the top of the display region.
7. When the data you want to print has scrolled off the top, press F4 Log Top
again. The asterisk disappears, indicating that Log Top has been turned off.
8. Press F1 Device Control from the Device Modes keys.
9. Press F4 Advance Page to send a form feed command to the printer. The
printer prints any remaining data.
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LOG

BOTTOM

WS92 menus
To Log Bottom, using the pull-down menus:
1. Select Log Bottom from the Print menu. A checkmark appears next to the
command, indicating that Log Bottom is active.
2. Continue your host session. WS92 sends each line that is terminated by a
Line Feed to the printer.
3. Select Log Bottom again. The checkmark disappears, indicating that Log
Bottom has been disabled.
4. To flush any remaining data from the printer, select Advance Page from
the Print menu to send a form feed command to the printer. The printer
prints any remaining data.
WS92 function keys
Log Bottom using the HP function keys:
1. Follow steps 1 through 4 in the WS92 portion of the Log Top section above.
2. Follow steps 5 through 9 in the WS92 portion of the Log Top section above,
only press F3 Log Bottom.
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USING

RECORD MODE MANUALLY

MS92 allows you to send host data to the printer without sending it to your
screen. This is known as using record mode. To use record mode:
1. Access the system keys using the function key scroll bar in WS92.
2. Press F1 Device Control.
3. From the Device Control keys, press F2 To External Device. An asterisk
appears in the function key label, indicating that the external device is active.
4. Press F1 Device Modes.
5. Type the command you wish to send to the host computer, but DO NOT
press RETURN.
6. From the menu of Device Modes keys, press F2 Record Mode. An asterisk appears in the function key label, indicating that record mode is enabled.
7. Press RETURN. The host sends data directly to your printer without sending it to your screen.
8. When the data has been printed, press F2 Record Mode again. The asterisk disappears, indicating that record mode has been disabled.
9. To flush any remaining data from the printer press F1 Device Control
from the device modes keys, then press F4 Advance Page. Or, select
Advance Page from the Print menu. This command sends a form feed
command to the printer, which causes the printer to print any remaining
data.
Note: Some applications on the host will use escape sequences to turn record
mode off. This is controlled by the program and does not require the user to set
up anything. When the Host program controls the record mode the print driver
should be set to Pass Through.
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COPY

LINE, COPY PAGE, AND COPY ALL

Copy a block of display memory and send it to the printer, using the HP function
keys or commands from the Print menu.

COPY

LINE

To copy a line of display memory and send it to the printer, follow the instructions below.
WS92 menus
1. Select Print Line from the Print menu. The line where the cursor is positioned is sent to the printer.
2. Select Advance Page from the Print menu, to send a form feed character
to the printer.
WS92 function keys
Use the HP function keys to print a line of display memory on the printer:
1. To access the system keys, use the function key scroll bar in WS92.
2. Press F1 Device Control.
3. From the menu of Device Control keys, press F2 To External Device. An
asterisk appears in the function key label, indicating that the external device is the active output device.
4. Position the cursor somewhere in the line you wish to print.
5. Press F8 Copy Line. The line where the cursor is positioned is sent to the
printer.
6. Press F4 Advance Page, or select Advance Page from the Print menu, to
send a form feed character to the printer.
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COPY PAGE
To copy a page of display memory and send it to the printer, follow the instructions below.
WS92 menus
1. Select Print to end of Page from the Print menu.
or
Select Print Current Page from the Print menu (ALT-PgDn) to send the
currently visible contents of the screen to the printer.
2. Select Advance Page from the Print menu, to send a form feed character
to the printer. The printer prints the page.
WS92 function keys
Use the HP function keys to print a page of display memory on the printer:
1. Follow steps 1 through 3, above, for Copy Line with HP function keys.
2. Scroll the display so the text you want printed is visible.
3. Press F7 Copy Page. All text currently visible on the screen is sent to the
printer.
4. Press F4 Advance Page, or select Advance Page from the Print menu, to
send a form feed character to the printer. The printer prints the page.

COPY ALL
To copy the entire contents of display memory and send it to the printer, follow
the instructions below.
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WS92 menus
1. Select Print Memory from Cursor from the Print menu.
or
Select Print All Display Memory from the Print menu to print the contents
of the display memory.
Note: Increase or decrease the amount of display memory by configuring
the number of pages in the Screen Configuration dialog box. (See Chapter
2)
2. Select Advance Page from the Print menu to send a form feed character
to the printer. The printer prints the text.
WS92 function keys
Use the HP function keys to print the contents of display memory to the printer:
1. Follow steps 1 through 3, above, for Copy Line with HP function keys.
2. Position the cursor at the beginning of the block you wish to print.
3. Press F6 Copy All. All display memory, from the current cursor position to
the end, is sent to the printer.
4. Press F4 Advance Page, or select Advance Page from the Print menu, to
send a form feed character to the printer. The printer prints the text.

MINISOFT 92

7-15

CHAPTER 7: PRINTING FROM MS92

SENDING

HOST DATA TO A PC FILE

With MS92, store host data directly on your PC in the following ways:
♦

Capture data to file.

♦

Select a block of text and paste it into a document.

CAPTURE

TO DISK

You can write data to a file as it is displayed to the screen using the Capture to
Disk utility.
To Capture to Disk:
1. Access the system keys using the function key scroll bar in WS92. Press
F5 Capture to Disk. An asterisk in the key label indicates that this utility is
active.
or
Select Capture to Disk from the File menu. A checkmark appears next to
the command.
2. Enter a fully-qualified PC file name (for example, C:\WS92\HPFILE.TXT),
and press RETURN. Everything displayed to the screen is sent to the specified file.
3. To stop capture data, press F5 Capture to Disk from the System keys.
The asterisk disappears.
or
Re-select Capture to Disk from the File menu.
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COPY

AND PASTE

The Edit menu in WS92 includes commands that allow you to copy blocks of
text to the Windows clipboard, where you can paste them into any Windows
application.

PRINTING

FROM A PC TO A HOST PRINTER

MS92 allows you to print PC files on a printer attached to the host. To print to
a host-based printer:
1. Be sure your host printer is defined in the File Transfer Configuration dialog box.
Enter the logical device number or device name in the “Host Printer Name”
field. If your host printer is connected serially, you must add /s to the device
name (for example, lp/s). You can also direct PC files to a diskfile on the
host by entering DISC/S in this field. On the host, the file will be called
MWLIST.
2. Logon to the host, if have not already.
3. Verify that a MS92 host link program exists on the host computer (see
Chapter 6 for information on host link programs).
4. Use the function key scroll bar to access the System keys, and press F7
Print to Host.
or
Select Print File on Host Printer from the Print menu.
When MS92 prompts you for a file to print, type a fully qualified path designation (for example, C:\WS92\HPFILE.TXT) and press RETURN. You may direct spreadsheets, PC graphics, and word processing documents to printers
attached to the host computer.
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BREAKING

AND RESETTING A CONNECTION

While running a host connection, you may need to break or reset the connection if for example the connection “hangs”.
Break the connection by selecting Break from the Trouble menu (ALT-B),
or select Disconnect from the Trouble menu.
Reset the connection by selecting Soft Reset from the Trouble menu (ALTS), or select Hard Reset from the Trouble menu (ALT-R).

BREAK
Selecting Break or pressing ALT-B while in remote mode breaks the computer operation to the host computer; you may need to abort your host
session after issuing this command. Break transmits a 200ms space on the
asynchronous transmit-data communication line. This serves as a signal to
interrupt computer operations between the PC and host computer.

DISCONNECT
Selecting Disconnect breaks the connection over a modem or network. For
a modem connection, Disconnect lowers DTR for two seconds. On a network connection, Disconnect breaks the connection and WS92 responds
with this message:
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Available Options:
Click Retry to reestablish the connection.
Click Configure to configure a different connection.
Click Exit to exit from WS92.
Click Load to open a configuration.
Click Offline to disconnect from the host and keep current WS92 window
open.

SOFT

RESET

Selecting Soft Reset or ALT-S:
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♦

Rings the terminal bell.

♦

Halts any device operations currently in progress.

♦

Enables the keyboard (if disabled).

♦

Clears any existing error conditions and removes the error message
display (if present) from the bottom of the screen.

♦

Disables display functions mode (if enabled).

♦

If record mode is on, a soft reset will turn it off.

♦

Halts any datacomm transfers currently in progress and clears the
datacomm buffer.
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HARD

RESET

Selecting Hard Reset or pressing ALT-R has the same effect as turning the
terminal power off and then back on. A hard reset:
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♦

Rings the terminal bell.

♦

Halts any device operations currently in progress.

♦

Enables the keyboard (if disabled).

♦

Clears all display memory.

♦

Clears any existing error conditions and removes the error message
display (if present) from the bottom of the screen.

♦

Halts any datacomm transfers currently in progress and clears the
datacomm buffer.
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DEBUGGING

PROBLEMS

WS92 can be run in debug mode, allowing you to diagnose problems and
program failures. In addition, WS92 includes a number of trace utilities
used by Minisoft technical support personnel for debugging problems.
WS92’s debugging utilities consist of:
♦

Debug mode

♦

Event trace

♦

Connection trace

♦

Packet capture

♦

Comms status report

NOTE.......
It is recommended to use the above options only after consulting Minisoft technical
support.
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DEBUG MODE

To run WS92 in debug mode:
1. Select Debug from the Trouble menu. A checkmark appears next to
the command, indicating that Debug Mode is active.
2. Continue your session. WS92 displays debug messages to your screen
as it runs.
3. Reselect Debug from the Trouble menu to turn Debug Mode off. The
checkmark disappears.

EVENT

TRACE

Event Trace tracks problems between WS92 and a host application. If WS92
does not seem to be handling a host application properly, use this utility.
To run Event Trace:
1. At a colon prompt (prior to running the application), select Event Trace
from the Trouble menu. The Save As dialog box appears.
2. Enter a name for the trace file in the File Name box and click OK. The
extension for event trace files is .EVT.
3. Run your host application so the trace utility can record the activity,
including errors.
4. When the problem has occurred, select Event Trace to turn off the
trace utility.
5. Send the trace file on a diskette to Minisoft, or email the file as an
attachment to support@minisoft.com with a note pertaining to the problem. The trace file allows a technician to identify any problems between WS92 and the host application.

MINISOFT 92

8-7

CHAPTER 8: TROUBLESHOOTING

CONNECTION

TRACE

Connection Trace activates messages that inform you of the status of your
attempt to connect to the host computer.
To run Connection Trace:
1. Select Connection Trace from the Trouble menu. A checkmark appears, indicating that the Connection Trace is active.
2. Attempt to make a connection, using Comms and Network selections
from the Config menu.
3. When you click Activate, WS92 reports its status as it attempts to make
the connection.
4. Note each message and click OK. When calling Minisoft for technical
support, report the contents of these messages to your technician.

PACKET

CAPTURE

Packet Capture records activity on a network. If WS92 does not seem to be
communicating properly on a network, use this utility.
To run Packet Capture:
1. Select Packet Capture from the Trouble menu. The Save As dialog
box appears.
2. Enter a name for the packet capture file in the File Name box, and
click OK. The extension for packet captures is .WPK.
3. Run your session on the network so the packet capture utility can record
the activity, including errors.
4. Send the packet capture file on a diskette to Minisoft, or email it as an
attached file to support@minisoft.com. The packet capture allows a
technician to identify any problems between WS92 and your network.
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COMMS

STATUS REPORT

This utility generates a screen report of communication problems relating
to the network. A technician at Minisoft may ask you to run this utility if
your system appears to be experiencing data communication problems.
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PRINTING

FROM NMCONFIG

In order to troubleshoot data communication problems that involve an HP
e3000 on a network, it may be useful to print configuration information
from the NMCONFIG utility. The MPE utility NMCONFIG allows for
simple and safe printing of configurations from a command line interface.
These instructions are provided because improper use of the NMMGR
screen interface can result in the loss of use of devices upon the next reboot.
The following procedures produce an output that is formatted for easy transmission by fax. Replace the reference to LP with an appropriate printer for
your site.
♦

For NETXPORT (TCP/IP) configuration:
:FILE FORMLIST;DEV=LP;REC=-80,,F,ASCII
:FILE NMMGRCMD=$STDINX
:NMMGR
NMMGR>OPENCONF NMCONFIG
NMMGR>SUMMARYCONF NETXPORT
NMMGR>EXIT

♦

For complete DTC configuration:
:FILE FORMLIST;DEV=LP;REC=-80,,F,ASCII
:FILE NMMGRCMD=$STDINX
:NMMGR
NMMGR>OPENCONF NMCONFIG
NMMGR>SUMMARYCONF DTS ALL
NMMGR>EXIT

♦

Subsets of the DTC configuration are also available:
NMMGR>SUMMARYCONF DTS DTC
NMMGR>SUMMARYCONF DTS LDEV
NMMGR>SUMMARYCONF DTS PROFILE
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LOSING

A CONNECTION

Sometimes, a network problem will cause your PC to be disconnected from
the host. You will also lose a connection if you fail to log on to the host. If
this happens, an offline message appears with the following options:
♦

Select Retry, and MS92 will attempt to reconnect you to your host.

♦

Select Configure to configure the connection. Select the settings to
match your network in the Type of Connection and the Network Configuration dialog box.

♦

Select Quit or Exit if you wish to exit MS92.

♦

Select Load.

♦

Select Offline.

RUNNING

THE COMMAND LANGUAGE

While MS92 is carrying out commands from a script file, it will report
error messages regarding problems it encounters:
Invalid Script Line
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♦

This error occurs when you execute a command that is not valid.

♦

Make sure the last line of your script contains the END command.
This command marks the end of the script.
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TRANSFERRING

FILES

MS92 may report one of several errors if there is a problem transferring a
file. Some error messages specifically address uploading of the host program.

FILE

TRANSFER ERRORS

Could not connect to host program / Could not open host file:
♦

WS92 must access the host program from the system prompt. Make
sure you are logged on to the host, and that you are not running a host
application. Your session must be at the CI (Command Interpreter)
Level .

♦

The host program(s) may have been corrupted during the upload procedure. Confirm that the uploading of the host program(s) was done
with parity set to None/8. Any other parity settings during a host program upload will result in corrupted host program(s). Upload the host
program again with the correct parity.

UPLOAD

HOST PROGRAM ERRORS

Error writing to host file:
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♦

This error signals that you may not be logged onto your host computer
system. Be sure you have logged on before attempting to upload the
host program.

♦

The term type (terminal type) is not 10. Logon HELLO
USER.ACCOUNT;TERM=10 to force the term type.

♦

Indicates that there may be a conflicting FCOPY UDC set on the host
computer system. Remove the FCOPY UDC and upload the host program again.
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♦

Attempting to upload the host program through an X.25 network or
data switch can cause this error to occur. If possible, upload the host
program through a direct serial or LAN connection.

File WS92LINK.PUB.SYS not found:
The file WS92LINK does not exist on the PC or WS92 cannot find it to
upload.

MINISOFT 92
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INSTALLING WS92
If MS92 will not run after you first install, there may be a problem with the
WinSock connection (WS92 only) or the serial connection was not configured properly.

FONT
Mismatch in Font. Family: Height Requested: 12702, Actual Height: 15361:
This error indicates that you are using an old version of the W92.FON font
file from a previous version of WS92. Select Fonts in the Windows Control Panel to remove the old file from the hard disk, and install the current
W92.FON from your latest version of WS92. You can not copy a current
version of W92.FON over the existing version.

WINSOCK

CONNECTIONS

Cannot find WINSOCK.DLL:
The WINSOCK.DLL file is missing, has been changed, or is not in the
correct path. This message may also appear if more than one
WINSOCK.DLL is on your system.
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♦

Delete any extraneous WINSOCK.DLL files.

♦

Install one and only one WINSOCK.DLL.

♦

Make sure the WINSOCK.DLL you are using is meant to be used
with the TCP/IP stack you are using. WINSOCK.DLLs can be used
only with the TCP/IP stack they were designed for.
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INITIAL

EXECUTION OF

MS92

The first time you run MS92, there is no existing default configuration file.
In addition, there may be cases where foreground and background color
enhancements are the same. The following messages are commonly displayed on the initial execution of MS92:
File DEFAULT.W92 not found / File MS92.CFG not found:
DEFAULT.W92 is the WS92 default configuration file.
Press RETURN or click OK to dismiss the message. After you configure
your settings, save them using the Save command. These settings become
your default configuration, which WS92 runs the next time you execute it.
Invalid color settings adjusted. Foreground equaled background:
One or more color enhancements are configured so that foreground and
background are the same (for example, white text on a white background).
Go to Color Configuration and adjust the settings so foregrounds are different from their background enhancements.
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CONFIGURING

A ROUTER/GATEWAY IN NMMGR

The HP e3000 refers to routers as internet gateways. This does not necessarily mean that you will be connecting to the Internet, although connection to the Internet could be one of the reasons routers are being added to
networks.
The HP e3000 needs to be configured with information about where the
routers are and what it can find on the other side of them.

GLOSSARY
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♦

A Local Area Network (LAN) is what you have in a single facility of
one or more buildings. You will likely have one or more IP networks
on each LAN.

♦

A Wide Area Network (WAN) is two or more LANs tied together. The
LANs’ areas are usually in different cities or states. It would be very
rare to have only one IP network on a WAN.

♦

Nodes are devices that have network interfaces. Nodes include HP
e3000s, PCs, routers, servers, communication servers, and just about
anything else that needs to communicate across the network.

♦

Each network interface has a unique IP Node Address. You can either
set up a server that will assign the number for each device at boot-up or
you can maintain a list and assign users from it. Some devices can
have more than one IP node address.

♦

IP Networks are groups of nodes separated by routers. An IP network
address is distinguished from a device IP node address by ending in
one or more zeros.

♦

IP Addresses are formed of four numbers separated by periods with
each number having a range of 001 to 254. The values of 000 and 255
are used by the protocols and cannot be used in the fourth place. A
sample IP node address is 192.168.001.025. A leading zero in each of
the four parts of an IP address is optional; most systems will recognize
either form of the address, but some systems are sensitive to this and
may not work if it is included.

B-3

APPENDIX B: IP ROUTER

♦

Subnet or network mask is a term used for dividing an A, B, or C class
address into multiple smaller networks.

EXAMPLE
Suppose a network has several PCs, one HP e3000 and a Novell NetWare
4.1 file server acting as an IP router. The IP addresses are as follows:
Net A
Net B
HP e3000
NetWare(1)
NetWare(2)
PC1
PC2
PC3
PC4

192.168.001.000
192.168.002.000
192.168.001.001
192.168.001.002
192.168.002.002
192.168.001.003
192.168.001.004
192.168.002.005
192.168.002.006

Note that the NetWare server has two IP node addresses; one for each of
the two network adapters, each on its own IP network.
We have found that if the number of devices on the total network is not
going to exceed 254, and if they are all located in the same facility, it is
easier to manage numbering them if each device has a unique last number
in the address. In this example, all the nodes have unique numbers and the
only repeat is for the file server. The file server’s two cards use the same
last digit but different network numbers.

PROCEDURES
Logon as MANAGER.SYS and edit the NMCONFIG file with NMMGR.
Include information about where the routers are located and what networks
are available. Validate the information and use JCONFJOB.NET to update
the permanent MPE network tables. Use NETCONTROL UPDATE to activate the new settings.
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MPE/IX

STEP

1

:HELLO username,MANAGER.SYS
:NMMGR
Open Config
F1
NS
F2
Unguided Config
F2
Go To NETXPORT
F1
Go To NI
F3

The Network Interface Name is probably LAN1. If some other name is
presented, take note of it. You will need to substitute this name in other
commands.
Then press:
Modify
Go To INTERNET
♦

If you are modifying an existing gateway/router; type the name as shown
in the list into the field labeled Gateway Name. Then press:
Modify

♦

F6
F3

F6

If you are adding a new gateway/router, type the name in the field labeled Gateway Name. Then press:
Add

F5

Type the IP address of the network card or interface that is on the same
section of the network as the HP e3000 into the field labeled Neighbor
Gateway IP Internet Address. Using the example network, 192.168.001.002
would be entered.
Type the IP network address(es) for the networks that are on the other side
of this router into the field labeled IP Network Address. Include all networks that can be reached through this router. The example network would
use 192.168.002.000. If this is the only router or the default router, use an
at sign, @, in this field in place of any specific address.
In most cases leave the IP Mask field blank. You may need to use this if
you use a subnet of a class A, B, network.
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Hops refers to the number of routers that must be crossed to reach the
network specified. Most networks will use the value of one for Hops. This
value can go as high as 1024 for special cases. If you are configuring this
as the default router, use 1024. Packets going to a network specified on this
line must go through other router(s), using a value greater than one.
After you have entered all the network values, press:
SAVE CONFIG
Prior Screen
UTILITY
Go To VALIDATE
Validate NETXPORT

F6
F8 (7 times)
F5
F3
F1

After you verify that the validation was successful, press:
Prior Screen
Exit Program
:

MPE/IX

STEP

RETURN
F8 (3 times)
F8

2

Use the following command to update the DSDAD (DADCONF.NET.SYS)
file.
:STREAM JCONFJOB.NET

Wait for this JOB to complete and check the STDLIST. If there are no
errors, continue with the last step.
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MPEI/X

STEP

3

You do not need to restart your system or stop virtual terminal access to
enable the new configuration. The NETCONTROL command has an UPDATE option that allows this information to be added dynamically.
Do not use this command if you are changing existing routes that are currently in use.
:NETCONTROL NET=LAN1;UPDATE=INTERNET

Your system should now be ready to use through your router(s).
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TYPOGRAPHICAL

CONVENTIONS

^
Control character, which stands for the CTRL key. The ^ control
character combined with another character forms a control code, as
shown in Appendix F.
^[
Escape code. See Appendix C for escape sequences, and the GOSUB
command for an example.
To display a control character (^) in a string as a non control character,
use a double caret ( ^^ ) to neutralize it as a control character. See the
following example:
DISPLAY “This is a ^^”
END
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TERMINAL

FUNCTIONS

The following table lists HP terminal control functions and their PC
keyboard equivalents in MS92. The terminal control functions are often
activated by a series of up to three terminal keys, as shown in the Terminal Key(s) column.

C-4

Termi nal Keys(s)

Code

P C Key(s)

F uncti on

ENTER (as used in local
mode)

ESC0 Keypad Enter

Copy memory to destination(s)

SYSTEM, margins/tabs/col,
SET TAB

ESC1

Set tab

SYSTEM, margins/tabs/col,
CLEAR TAB

ESC2

Clear tab
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Termi nal Keys(s)

Code

P C Key(s)

F uncti on

SYSTEM, margins/tabs/col, ESC3
CLR ALL TABS

Clear all tabs

SYSTEM, margins/tabs/col, ESC4
LEFT MARGIN

Set left margin

SYSTEM, margins/tabs/col, ESC5
RIGHT MARGIN

Set right margin

SYSTEM, margins/tabs/col, ESC9
CLR ALL MARGINS

Clear all margins

ESC@

Delay one second



ESCA 

Cursor up



ESCB 

Cursor down



ESCC



Cursor right



ESCD



Cursor left

Hreset

ESCE

Alt-R

Hard reset (power on reset)

Home Down

ESCF

Ctrl-End

Cursor home down

RETURN (with Auto LF
disabled)

ESCG

ENTER (with
Auto LF
disabled)

Move cursor to left margin

Home Up

ESCH

Ctrl-Home

Cursor home up

Tab

ESCI

Tab

Horizontal tab

Clear Display

ESCJ

Alt-J

Clear display from cursor to
end of memory

Clear Line

ESCK

Alt-K

Clear line from cursor to end
of line

Ins Line

ESCL

Alt-I

Insert line

Del Line

ESCM Alt-D

Delete line

Del Char

ESCP

Delete character
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Te rminal Ke ys (s )

Code

PC Ke y(s )

Function

Ins Char

ESCQ

Insert

Start insert character mode

Ins Char

ESCR

Insert

End insert character (ESC Q)

Scroll Up

ESCS

Ctrl- 5

Scroll up

Scroll Down

ESCT

Ctrl- 6

Scroll down

Next Page

ESCU

Page Down

Next Page

Prev Page

ESCV

Page Up

Previous Page

ESCW

Format mode on

ESCX

Format mode off

Modes, DISPLAY
FUNCTION

ESCY

Display Functions mode on

Modes, DISPLAY
FUNCTIONS*

ESCZ

Display Functions mode off

ESC[

Start unprotected field

ESC]

End unprotected field

ESC^

Primary terminal status request

ESC'

Sense cursor position (relative)

ESCa

Sense cursor position (absolute)

ESCb

Unlock keyboard

ESCc

Lock keyboard

ESCd

Transmit a block of text to
computer

ESCf

Modem disconnect

ESCg

Soft reset

Home Up

ESCh

Crtl- Home

Cursor home up

Btab

ESCi

Shift- Tab

Backtab

Shift- User Keys

ESCj

Begin User Keys Definition mode
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Te rminal Ke ys (s )

Code

User K eys or SYSTEM or
MO DES

ESCk

End User K eys Definition mode

MO DES, MEMO RY LO CK

ESCl

Begin Memory Lock mode

MO DES, MEMO RY
LO CK *

ESCm

End Memory Lock mode

F1

ESCp

F1

Default definition for user
definable function key F1

F2

ESCq

F2

Default definition for user
definable function key F2

F3

ESCr

F3

Default definition for user
definable function key F3

F4

ESCs

F4

Default definition for user
definable function key F4

F5

ESCt

F5

Default definition for user
definable function key F5

F6

ESCu

F6

Default definition for user
definable function key F6

F7

ESCv

F7

Default definition for user
definable fuction key F7

F8

ESCw

F8

Default definition for user
definable function key F8

SYSTEM, service keys,
TERMIN AL TEST

ESCz

Initiate terminal self test

MO DES, TERMIN AL TEST

ESC^

Primary terminal status request

ESC~

Secondary terminal status request
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CURSOR

CONTROL OPERATIONS

The following table lists HP terminal control functions and their PC
keyboard equivalents in MS92. The terminal control functions are often
activated by a series of up to three terminal keys, as shown:
Escape Sequence

Operati o n

ESC&a <co l>c <ro ws>Y

Mo ves the curso r to co lumn co l and screen ro w ro w
o n the screen (relative addressing).

ESC&a <co l>c <ro w>R

Mo ves the curso r to co lumn co l and ro w ro w in
memo ry (abso lute addressing).

ESC&a± <co l>c ± <ro ws>Y

Mo ves the curso r to co lumn co l and ro w ro w (o n the
screen) relative to its present po sitio n (co l and ro w
are signed integers). A po sitive number indicates
right o r do wnward mo vements and a negative number
indicates left o r upward mo vement.

ESC&a ± <co l>c ± <ro ws>R

Mo ves the curso r to co lumn co l and ro w ro w relative
to its present po sitio n in memo ry (co l and ro w are
signed integers). A po sitive number indicates right o r
do wnward mo vements and a negative number
indicates left o r upward mo vement.

CONFIGURATION

OPERATIONS

The following table lists escape sequences for HP configuration operations, where replacing the value of <x> with the value shown in the X=
column yields the switch value shown.
To unlock a configuration, use this escape sequence: esc&q 0L
To lock a configuration, use this escape sequence: esc&q 1L
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Es cape Se que nce

Ope ration

Switch Value

X=

ESC&k <x>A

AUTO LF

Off
On

0
1

ESC&k <x>B

BLOCK

Off
On

0
1

ESC&k <x>C

Caps Lock

Off
On

0
1

ESC&k <x>J

FrameRate

60
50

0
1

ESC&k <x>L

LocalEcho

Off
On

0
1

ESC&k <x>M

MODIFY ALL

Off
On

0
1

ESC&k <x>N

SPO W

No
Yes

0
1

ESC&k <x>P

Caps Mode

Off
On

0
1

ESC&k <x>R

REMOTE

Off
On

0
1

ESC&s <x>A

XmitFnctn(A)

No
Yes

0
1

ESC&s <x>B

SPOW(B)

No
Yes

0
1

ESC&s <x>C

InhEolWrp(C)

No
Yes

0
1

ESC&s <x>D

Line/Page(D)

Line
Page

0
1

ESC&s <x>G

InhHndShk(G)

No
Yes

0
1

ESC&s <x>H

Inh DC2 (H)

No
Yes

0
1
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TERMINAL
There are two escape sequences to define the RETURN key on the 700/
94 terminal. These escape sequences allow a one-character or, acting in
combination, a two-character value to be mapped to the RETURN key.
The characters each have an ASCII value of 0-127.
ESC&q8 te 1{<x>A

Sets the first character o f the RETURN key definitio n;
x=0 -12 7 .

ESC&q8 te 1{<x>B

Sets the seco nd character o f the RETURN key
definitio n; x=0 -12 7 .

For example,
esc&q8te1{67A and esc&q8te1{114B

would yield a value of Cr.
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DATA

OPERATIONS

The following table lists escape sequences that control data transfer to and from the
integral printer and display memory of the HP e3000 host. These sequences are effective
only if a printer is present.
Es cape Se que nce

Ope ration

ESC&p <a>d <Y> Copies data specified by
Y to destination devices
a. As many destinations
as desired can be
specified.

De vice

Action

a=

Y=

3:
display

B: Copies the line in which
the cursor is located (cursor
line).

4,6:
printer

F: Copies the display screen
from the line in which the
cursor is located to the last
displayed line.
M: Copies the contents of
display memory from the
cursor line to the end of
memory.

ESC&p <x>^

Requests the status of
device x.

x=

--

4,6:
printer
ESC&k <x>S

Enables Expanded,
Compressed, or Normal
Character mode for the
integral printer as
designated by x.

--

x=
0: Disable both Expanded
and Compressed Character
modes.
1: Initiate Expanded
Character mode.
2: Initiate Compressed
Character mode.
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Es cape Se q.

Ope ration

De vice

Action

ESC&l <x>O

Enables page orientation to print
portrait or landscape as defined
by <x>.

ESC&p <y>u
<z>C

Performs the action specified by
z on device y.

y=
4,6:
printer
3:
display

z=
0: Generates one form feed.
1: Spaces x lines.
2- 10: Generates one form feed.
11: Turn on Log Bottom mode.
12: Turn on Log Top mode.
13: Turn off any logging mode.
14: Print normal characters.
15: Print expanded characters.
16: Print compressed characters.
17: Turn on Report mode.
18: Turn on Metric Report mode.
19: Turn off any Report mode.

ESC&p
<num>p 20C

Turns on Record mode.

--

--

--

--

x=
0: Portrait
l: Landscape.

"<num>p" is optional
<num> is the decimal equivalent
of an ASCII character that will
turn off record mode.

C-12

ESC&p <x>W
<data string>

Transfers x bytes of the data
string from the computer to the
selected destination device in
binary form.

ESC&p W
<data string>

Transfers the dat a st ring, in
ASCII form, from the computer
to the printer selected as the
destination device. The string is
terminated either by the 256th
byte or by an ASCII line feed
character.
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FUNCTION

KEY OPERATIONS

The following section shows the escape sequences necessary for using
and defining the function keys.

ENABLING

AND DISABLING FUNCTION KEYS

To enable and disable the function keys (F1 through F8), use this escape
sequence:
ESC&j <X>

where the value of x is one of the following:
X=

Ope ration

A

Displays the Modes set of function key labels.

B

Enables the User function keys (user key labels are displayed).

C

Clears the error message from the screen and returns the last displayed level of
fuction key labels.

@

Removes the fuction key labels from the screen, but leaves the keys enabled.

S

Disables the System, Modes, and User keys; in other words, disables changing
the function keys.

R

Enables the System, Modes, and User keys.

DEFINING

FUNCTION KEYS

You can use escape sequences to customize the labels of the function
keys and to program the action that the function keys perform.
To customize function key labels, use this escape sequence:
ESC&j <string length>L <message>

MINISOFT 92
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where string length is a number up to 160, indicating the number of
characters in the string. Message is the label to appear on the function
key.
To define functions for the function keys, use the following escape
sequence:
ESC&f <attribute>a <key>k <label length>d
<string length>L <label><string>

where the values of the terms are as follows:
Term

Val ue

a ttr ib u te

0
1
2

Normal (N)
Local only (L)
Transmit only (T)

key

1
2
3
4
5
6
7
8

F1
F2
F3
F4
F5
F6
F7
F8

function key
function key
function key
function key
function key
function key
function key
function key

la b e l le n g th

0 through 16

Number of characters in the label.

S tr in g le n g th

0 through 80

Number of characters in the string.

-1
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Meani ng

Clears the content of the string.

Label

Characters to appear on the function key.

S tr in g

Character string to transmit when key is
pressed.
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ESC&f <x>E

Executes the action assigned to Function Key x.
x
1-8
-1

Key
F1-F8
block mode enter

Example:
^[&f-1E

MINISOFT 92
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DISPLAY

ENHANCEMENT OPERATIONS

The following table shows the escape codes used for display enhancements. To start and end display enhancements, use this escape sequence:
ESC&d <char>

Where char is one of the following:

@ A

B

C

D

E

F

G H

I

J

K

L M N

O

•

•

•

•

•

•

•

•

•

•

•

•

•

•

Half-Bright
Underline

•

Inverse Video

•

Blinking

•

End Enhancement

•

•
•

•

•

•

•

•
•

•
•

•
•

•

•

•

The display enhancement specified by char in the escape sequence
begins at the current cursor position. For example, to select the underline, inverse video, blinking enhancement, use this escape sequence:
ESC&d G
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HOST-INITIATED

COMMANDS

There are three host-initiated commands:

MINISOFT 92

ESC&o B

Allo ws the ho st to initiate a script co mmand and return a result co de.

ESC&o C

Allo ws the ho st to initiate a script co mmand and return a result co de.

ESC&o F

Allo ws the ho st to initiate a script co mmand witho ut returning a result
co de.
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Versions 5.2 and later of WS92 have been enhanced to specifically support
the Ecometry MACS software package.
To take full advantage of Ecometry/MACS, use 5.2 or later along with the
included predefined Minisoft configuration files. Refer to the instructions
below on how these configuration files should be used. Remember these
files are already configured to work with Ecometry. You should not have
to make any significant changes to these files.

E IGHT

CONFIGURA
TION FILES
CONFIGURATION

There are eight Minisoft configuration files that are used with Ecometry/
MACS. Be sure and place all eight files in the directory where the
WS92.EXE is located. See table shown below:
DEFAULT.W92

Default configuration for standard MACS operation

R1.CFG

Used for many SGA screens - on special key mapping

R1ENTER.CFG

Used for SGA Accounting screens - Return=Enter

SGA.CFG
SGA2.CFG
SGA4.CFG
SGA5.CFG

Extensive key mapping - 80 or 132 column

SGA9.CFG

No key mapping - 132 column

When making changes to these files, be sure to make the identical changes
in all versions. If something does not work correctly after the changes,
start by making the changes to SGA9 then remove the differences, such as
column and key-mapping, to make a functional duplicate of the other files.
Select Save As when the settings match.
To configure the eight files use the script file SetupSga.s92. From the File
menu select Run a Script, then select SetupSGA.S92. For further information see the SGAReadme.rtf file.
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ASCII

He x

Scripts and
ke ymapping

0

00

1

Abbre viation

Action

^@

NUL

null

01

^A

SO H

start of heading

2

02

^B

STX

start of text

3

03

^C

ETX

end of text

4

04

^D

EOT

end of transmission

5

05

^E

ENQ

enquiry

6

06

^F

ACK

acknowledge

7

07

^G

BEL

bell

8

08

^H

BS

backspace

9

09

^I

HT

horizontal tab

10

0A

^J

LF

line feed

11

0B

^K

VT

vertical tab

12

0C

^L

FF

form feed

13

0D

^M

CR

carriage return

14

0E

^N

SO

shift out

15

OF

^O

SI

shift in
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ASCII

He x

Scripts and
ke ymapping

16

10

17

Abbre viation

Action

^P

DLE

delete

11

^Q

DC1

device control 1 (x- on)

18

12

^R

DC2

device control 2

19

13

^S

DC3

device control 3 (x- off)

20

14

^T

DC4

device control 4

21

15

^U

NAK

negative acknowledge

22

16

^V

SYN

synchronous idle

23

17

^W

ETB

end of block

24

18

^X

CAN

cancel line

25

19

^Y

EM

end of medium

26

1A

^Z

SUB

substitute

27

1B

^[

ESC

escape

28

1C

^\

FS

file separator

29

1D

^]

GS

group separator

30

1E

n/a

RS

record separator

31

1F

^-

US

unit separator
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Appendix F contains information on NFT and NFT’s FTP module.
♦

The NFT protocol communicates with the HP e3000.

♦

The FTP module communicates with Unix, IBM VM, VMS/Multinet,
VMS/UCX, FTP’s PCTCP, CUTCP/NCSA, NOS/KA9Q, WinQVT/
Net, IBMPC TCP/IP, CHAMELEON, SuperTCP, SI NT/FTPD, IBM
MVS, and Unisys 5000.

NFT’S OLE

AUTOMATION INTERFACE

Client programs can access WS92’s Network File Transfer (HP e3000 MPE/
iX) and/or FTP (Unix, etc.) module(s) via OLE automation. Any client
may create a Session object and use the object’s properties and methods to
communicate with the server program.
Note that the following two sections, File transfer engine (HP e3000 MPE/
iX) and FTP engine, are very similar but not identical.

NEED

FURTHER INFORMATION....

Chapter 6
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FILE

TRANSFER ENGINE

(HP E3000 MPE/IX)

The File Transfer Engine objects are used by the client program to communicate with the file transfer server program on the host. This gives the
client the ability to transfer files to/from the host as well as execute MPE
commands, MPE command files and programs. In order to access the File
Transfer Engine from a client program, the client program must create the
Session object of the File Transfer Engine as follows:
Visual BASIC:
Dim FTSession As Object
...
Set FTSession = CreateObject(“NetFT.Session”)

Visual C++:
CreateDispatch( “NetFT.Session” );

When the client program wishes to stop using the File Transfer Engine,
then it must delete the Session object as follows:
Visual BASIC:
Set FTSession = Nothing

Visual C++:
ReleaseDispatch();

SESSION OBJECT
Once the Session object has been created the client can access its properties and methods to access the host’s file transfer server program. Typically the properties specifying the host’s IP address, TCP/IP port number,
and login information are set, then the Connect method is called to connect
the host’s file transfer server program.

F-4
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PROPERTY REFERENCE
AccountPassword, type String, write access
String used for the account password when connecting to the host’s
file transfer server program.
ConnectStatus, type Boolean, read access
Contains True if the last connection attempt was successful, else False.
CtrlZIsEof, type Boolean, write access
This property specifies whether the end-of-file of a PC file is marked
with a CTRL-Z character or not. A value of True indicates that a
CTRL-Z found in the file will be interpreted as the EOF on uploads,
and that a CTRL-Z will be written at the end of the file on downloads.
A value of False indicates that a CTRL-Z found in the file will be
interpreted as normal data on uploads, and that a CTRL-Z will not be
written at the end of the file on downloads. This property only applies
to ASCII transfers. The default is False.
Direction, type integer, write access
Specifies the direction of the next file transfer. A value of 0 indicates
uploading, while a value of 1 indicates downloading. The default is
uploading.
DisplayStats, type Boolean, write access
This property specifies whether a dialog box showing the status of the
transfer should be displayed during the file transfer. The default is
False.
ErrorMessage, type String, read access
Contains the last error message generated.
ErrorNumber, type integer, read access
Contains the last error number generated.
ExistsAction, type integer, write access
This property specifies what action to take if the destination file already exists. A value of 0 indicates that the transfer should be canceled. A value of 1 indicates that the destination file should be deleted
and the transfer should continue. A value of 2 indicates that the user
should be prompted whether to delete the file or cancel the transfer. A
value of 3 indicates that the destination file should be appended to.
The default is 0.
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FileTransferStatus, type integer, read access
This property indicates the status of an in-progress or completed file
transfer. A value of 0 indicates that the last transfer was completed
successfully. A value of 1 indicates that the last transfer failed. Any
other value indicates that a file transfer or some other operation is in
progress.
GroupPassword, type String, write access
The string used for the group password when connecting to the host’s
file transfer server program.
HostAddress, type String, write access
The host name or IP address used when attempting to connect to the
host.
HostFile, type String, write access
This property specifies the name of the host file involved in the transfer. It may be fully qualified with the group and account if necessary.
If the file is in or should be created in the temporary domain, the string
“,TEMP” should be appended to its name.
HostFileList( String ListMask ), String, read access
This property returns a comma-delimited list of files on the host. The
ListMask parameter specifies a valid LISTF filename argument used
to compile the list with.
JobName, type String, write access
The string used for the job name when connecting to the host’s file
transfer server program.
KeepTrailingSpaces, type Boolean, write access
This property specifies what to do with the trailing spaces on each
record during ASCII downloads. A value of True indicates that trailing spaces should be kept, while a value of False indicates that trailing
spaces should be deleted. Default is False.
LocalFile, type String, write access
This property specifies the name of the local file involved in the file
transfer. It may be fully qualified with the drive letter and path if
necessary.
LoginAccount, type String, write access
The string used for the account name when connecting to the host’s
file transfer server program.
F-6
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LoginGroup, type String, write access
The string used for the group name when connecting to the host’s file
transfer server program.
LoginInfo, type String, read access
This property contains the current user name, group name, and account name the server is running from. The first 8 characters contain
the user name, the next 8 characters contain the group name, and the
last 8 characters contain the account name.
LoginStatus, type Boolean, read access
Contains True if the login information supplied when connecting to
the host file transfer server program was valid, else False.
LoginUser, type String, write access
The string used for the user name when connecting to the host’s file
transfer server program.
Port, type integer, write access
A number that uniquely identifies the program on the host that the
client wishes to connect to. This number is typically 31001 for the file
transfer server, but may be any numbered between 1 and 32767.
RecordSize, type integer, write access
This property specifies the record length of the host file for uploads.
Valid values are between 1 and 4096. Default is 80 for ASCII transfers, or 256 for binary transfers.
SpacesPerTab, type integer, write access
This property sets the distance between tab stops and enables changing tab characters to spaces to fill the next tab stop. It is used only on
ASCII uploads. A value of 0 disables the replacement of tab characters. Valid values are between 0 and 9. Default is 0.
TransferMode, type integer, write access
This property specifies the mode of the file transfer. Valid values are
0 for an ASCII file transfer, 1 for a binary file transfer, and 2 for a
binary transfer that saves the file information in a file header.
UserPassword, type String, write access
The string used for the user password when connecting to the host’s
file transfer server program.
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METHOD REFERENCE
Boolean Connect()
This method attempts to connect to the host’s file transfer server program at the IP address specified by the HostAddress property. The
Port property is used to identify the requested host program. Connect
sets the ConnectStatus property and returns True if the connection request succeeded, else it returns False.
void Disconnect()
This method disconnects from the host’s file transfer server program.
integer HostCommand( String CommandString )
This method executes a MPE command or MPE command file. The
CommandString parameter specifies the command or command file to
be executed. A return of 0 indicates the command was executed successfully, while a return of 1 indicates that the command failed.
Boolean HostLogin()
This method changes the host server login to that specified by the
LoginUser, UserPassword, LoginGroup, GroupPassword,
LoginAccount, AccountPassword, and JobName properties. A return
of True indicates that the login was changed successfully.
void SaveConfig()
This method saves the writable session object properties to a file. This
file can later be use to initialize a session object when created.
Boolean LoadConfig( String FileName )
This method loads the session object properties from the named file.
A return of True indicates the properties were loaded successfully.
Boolean SetSessionConfig()
This method displays the “Session Configuration” dialog of the File
Transfer Access Engine. This dialog allows the user to set the following properties: HostAddress, Port, LoginUser, UserPassword,
LoginGroup, GroupPassword, LoginAccount, AccountPassword, and
JobName. A return of True indicates the user clicked on OK to exit the
dialog, else a return of False indicates the user clicked on Cancel to
exit the dialog.
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Boolean SetTransferConfig()
This method displays the “File Transfer Configuration” dialog of the
File Transfer Access Engine. This dialog allows the user to set default
file transfer options. A return of True indicates the user clicked on OK
to exit the dialog, else a return of False indicates the user clicked on
Cancel to exit the dialog.
integer StartTransfer()
This method initiates a file transfer. A return of 0 indicates the file
transfer was successful, while a return of 1 indicates that the file transfer failed.

FTP

ENGINE

The FTP engine objects are used by the client program to communicate
with a FTP server program on the host. This gives the client the ability to
transfer files to/from any host that supports FTP. In order to access the
FTP engine from a client program, the client program must create the Session object of the FTP engine as follows:
Visual BASIC:
Dim FTPSession As Object
...
Set FTPSession = CreateObject(“MdmFTP.Session”)

Visual C++:
CreateDispatch( “MdmFTP.Session” );

When the client program wishes to stop using the FTP Engine, then it must
delete the Session object as follows:
Visual BASIC:
Set FTPSession = Nothing

Visual C++:
ReleaseDispatch();
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SESSION OBJECT
Once the Session object has been created the client can access its properties and methods to access the host’s FTP server program. Typically the
properties specifying the host’s IP address and login information are set,
then the Connect method is called to connect the host’s FTP server program.

PROPERTY REFERENCE
AccountPassword, type String, write access
The string used for the account password when connecting to the host’s
FTP server program. Some hosts require account information.
ConnectStatus, type Boolean, read access
Contains True if the last connection attempt was successful, else False.
CtrlZIsEof, type Boolean, write access
This property specifies whether the end-of-file of a PC file is marked
with a CTRL-Z character or not. A value of True indicates that a
CTRL-Z found in the file will be interpreted as the EOF on uploads,
and that a CTRL-Z will be written at the end of the file on downloads.
A value of False indicates that a CTRL-Z found in the file will be
interpreted as normal data on uploads, and that a CTRL-Z will not be
written at the end of the file on downloads. This property only applies
to ASCII transfers. The default is False.
DirectoryList, type String, read access
This property contains a list of subdirectories contained by the current
host directory. It is updated after every successful call to the
RefreshFileList method.
DisplayStats, type Boolean, write access
This property specifies whether a dialog box showing the status of the
transfer should be displayed during the file transfer. The default is
False.
ErrorMessage, type String, read access
Contains the last error message generated.
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ErrorNumber, type integer, read access
Contains the last error number generated.
FileList, type String, read access
This property contains a list of files contained by the current host directory. It is updated after every successful call to the RefreshFileList
method.
FileTransferStatus, type integer, read access
This property indicates the status of an in-progress or completed file
transfer. A value of 0 indicates that the last transfer was completed
successfully.
HostAddress, type String, write access
The host name or IP address used when attempting to connect to the
host.
HostType, type integer, write access
This property specifies the type of host your connecting to. Valid types
are:
1 - Unix
2 - IBM VM
3 - VMS/Multinet
4 - VMS/UCX
5 - FTP’s PCTCP
6 - CUTCP/NCSA
7 - NOS/KA9Q
8 - WinQVT/Net
9 - IBMPC TCP/IP
10 - CHAMELEON
11 - SuperTCP
12 - SI NT/FTPD
13 - IBM MVS
14 - Unisys 5000
LoginStatus, type Boolean, read access
Contains True if the login information supplied when connecting to
the host’s FTP server program was valid, else False.
LoginUser, type String, write access
The string used for the user name when connecting to the host’s FTP
server program.
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SpacesPerTab, type integer, write access
This property sets the distance between tab stops and enables changing tab characters to spaces to fill the next tab stop. It is used only on
ASCII uploads. A value of 0 disables the replacement of tab characters. Valid values are between 0 and 9. The default is 0.
UserPassword, type String, write access
The string used for the user password when connecting to the host’s
FTP server program.

METHOD REFERENCE
Boolean ChangeDirectory( String Directory )
This method attempts to change the current directory of the host’s FTP
server program to the directory specified by the Directory parameter.
A return of True indicates that the current directory was changed.
Boolean Connect()
This method attempts to connect to the host’s FTP server program at
the host name or IP address specified by the HostAddress property.
The LoginUser, UserPassword, and AccountPassword (optional) properties should be set before calling the Connect method. Connect sets
the ConnectStatus property and returns True if the connection request
succeeded, else it returns False.
String CurrentDirectory()
This method returns the name of the current directory of the host’s
FTP server program.
Boolean DeleteFile( String FileName )
This method deletes the host file specified by the FileName parameter.
A return of True indicates that the file was deleted.
void Disconnect()
This method disconnects from the host’s FTP server program.
Boolean Login()
This method changes the host server login to that specified by the
LoginUser, UserPassword, and AccountPassword (optional) properties. A return of True indicates that the login was changed successfully.
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Boolean RefreshFileList( String ListPath )
This method retrieves a list of all files and directories matching the
ListPath parameter. The ListPath parameter may contain any valid
path and/or file wildcard characters. The DirectoryList and FileList
properties are updated upon successful completion of this method.
Boolean RenameFile( String OldName, String NewName )
This method renames the file specified by the OldName parameter to
the name specified by the NewName parameter. A return of True indicated that the rename was successful.
integer RetrieveFile( String HostFileName, String LocalFileName, integer Type,integer ExistsAction )
This method transfers the file specified by the HostFileName parameter from the host to the file specified by the LocalFileName parameter on the PC. The Type parameter is either 0 for an ASCII transfer or
1 for a binary transfer. The ExistsAction parameter specifies what
action to take if the PC file already exists. A value of 0 indicates that
the transfer should be canceled. A value of 1 indicates that the PC file
should be deleted and the transfer should continue. A value of 2 indicates that the user should be prompted whether to delete the file or
cancel the transfer. A value of 3 indicates that the PC file should be
appended to. A return value of 0 indicates that the transfer was completed successfully.
Boolean SetSessionConfig()
This method displays the “Session Configuration” dialog of the FTP
Engine. This dialog allows the user to set the following properties:
HostAddress, HostType, LoginUser, UserPassword, and
AccountPassword. A return of True indicates the user clicked on OK
to exit the dialog, else a return of False indicates the user clicked on
Cancel to exit the dialog.
Boolean SetTransferConfig()
This method displays the “File Transfer Configuration” dialog of the
FTP Engine. This dialog allows the user to set default file transfer
options. A return of True indicates the user clicked on OK to exit the
dialog, else a return of False indicates the user clicked on Cancel to
exit the dialog.
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integer StoreFile( String LocalFileName, String HostFileName, integer
Type,integer ExistsAction )
This method transfers the file specified by the LocalFileName parameter from the PC to the file specified by the HostFileName parameter
on the host. The Type parameter is either 0 for an ASCII transfer or 1
for a binary transfer. The ExistsAction parameter specifies what action to take if the host file already exists. A value of 1 indicates that
the host file should be deleted and the transfer should continue. A
value of 3 indicates that the host file should be appended to. A return
value of 0 indicates that the transfer was completed successfully.

CALLING OLE AUTOMATION ENGINES FROM VISUAL C++
Type libraries to describe the API for the File Transfer Engine and the FTP
Engine are included in the installation directory. They are called
MDMFT.TLB and MDMFTP.TLB respectively. They can be used with
the Read Type Library option under the OLE automation tab of the
ClassWizard dialog box of Microsoft Visual C++.
When a type library is read this way, a new class derived from
COleDispatchDriver is created which will contain member functions to
access the properties and methods of the requested OLE automation engine.
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Ro man 9 Character Set Co des
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ASCII

HEX

DEC

OCT

DESCRIP TION

NULL

00

0

000

Null

SOH

01

1

001

Start o f heading

STX

02

2

002

Start o f text

EXT

03

3

003

End o f text

EOT

04

4

004

End o f transmissio n

ENQ

05

5

005

Enquiry

ACK

06

6

006

Ackno wledge

BEL

07

7

007

Bell

BS

08

8

010

Backspace

HT

09

9

0 11

Ho rizo ntal tabulatio n

LF

0A

10

012

Line feed

VT

0B

11

013

Vertical tabulatio n

FF

0C

12

014

Fo rm Feed

CR

0D

13

015

Carriage Return

SO

0E

14

016

Shift o ut

SI

0F

15

017

Shift in

DLE

10

16

020

Data link escape

DC1

11

17

021

Device co ntro l 1 o r X-ON

DC2

12

18

022

Device co ntro l 2

DC3

13

19

023

Device co ntro l 3 o r X-OFF

DC4

14

20

024

Device co ntro l 4
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ASCII

HEX

DEC

OCT

DESCRIP TION

NAK

15

21

025

Negative ackno wledge

SYN

16

22

026

Synchro no us idle

ETB

17

23

027

End o f transmissio n blo ck

CAN

18

24

030

Cancel

EM

19

25

031

End o f medium

SUB

1A

26

032

Substitute

ESC

1B

27

033

Escape

FS

1C

28

034

File separato r

GS

1D

29

035

Gro up separato r

RS

1E

30

036

Reco rd separato r

US

1F

31

037

Unit separato r

20

32

040

Space

!

21

33

041

Exclamatio n po int

"

22

34

042

Quo tatio n mark

#

23

35

043

Number sign (hash mark)

$

24

36

044

Do llar sign

%

25

37

045

P ercent sign

&

26

38

046

Ampersand

'

27

39

047

Apo stro phe (clo sing single quo te)

(

28

40

050

Opening parenthesis

)

29

41

051

Clo sing parenthesis

*

2A

42

052

Asterisk

+

2B

43

053

P lus

,

2C

44

054

Co mma

-

2D

45

055

Hyphen (minus)

.

2E

46

056

P erio d (po int)

/

2F

47

057

Slant (so lidus)
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HEX

DEC

OCT

DESCRIP TION

0

30

48

060

Zero

1

31

49

061

One

2

32

50

062

Two

3

33

51

063

Three

4

34

52

064

Fo ur

5

35

53

065

Five

6

36

54

066

Six

7

37

55

067

Seven

8

38

56

070

Eight

9

39

57

071

Nine

:

3A

58

072

Co lo n

;

3B

59

073

Semico lo n

<

3C

60

074

Less than sign

=

3D

61

075

Equal sign

>

3E

62

076

Greater than sign

?

3F

63

077

Questio n mark

@

40

64

100

Co mmercial at

A

41

65

101

Uppercase A

B

42

66

102

Uppercase B

C

43

67

103

Uppercase C

D

44

68

104

Uppercase D

E

45

69

105

Uppercase E

F

46

70

106

Uppercase F

G

47

71

107

Uppercase G

H

48

72

110

Uppercase H

I

49

73

111

Uppercase I

J

4A

74

112

Uppercase J

G-5
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K

4B

75

113

Uppercase K

L

4C

76

114

Uppercase L

M

4D

77

115

Uppercase M

N

4E

78

116

Uppercase N

O

4F

79

117

Uppercase O

P

50

80

120

Uppercase P

Q

51

81

121

Uppercase Q

R

52

82

122

Uppercase R

S

53

83

123

Uppercase S

T

54

84

124

Uppercase T

U

55

85

125

Uppercase U

V

56

86

126

Uppercase V

W

57

87

127

Uppercase W

X

58

88

130

Uppercase X

Y

59

89

131

Uppercase Y

Z

5A

90

132

Uppercase Z

[

5B

91

133

Opening square bracket

\

5C

92

134

Reverse slant

]

5D

93

135

Clo sing square bracket

^

5E

94

136

Caret (circumflex)

_

5F

95

137

Undersco re (lo w line)

'

60

96

140

Opening single quo te

a

61

97

141

Lo wercase a

b

62

98

142

Lo wercase b

c

63

99

143

Lo wercase c

d

64

100

144

Lo wercase d

e

65

101

145

Lo wercase e
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f

66

102

146

Lo wercase f

g

67

103

147

Lo wercase g

h

68

104

150

Lo wercase h

i

69

105

151

Lo wercase i

j

6A

106

152

Lo wercase j

k

6B

107

153

Lo wercase k

l

6C

108

154

Lo wercase l

m

6D

109

155

Lo wercase m

n

6E

110

156

Lo wercase n

o

6F

111

157

Lo wercase o

p

70

112

160

Lo wercase p

q

71

113

161

Lo wercase q

r

72

114

162

Lo wercase r

s

73

115

163

Lo wercase s

t

74

116

164

Lo wercase t

u

75

117

165

Lo wercase u

v

76

118

166

Lo wercase v

w

77

119

167

Lo wercase w

x

78

120

170

Lo wercase x

y

79

121

171

Lo wercase y

z

7A

122

172

Lo wercase z

{

7B

123

173

Opening brace (curly bracket)

|

7C

124

174

Vertical line

}

7D

125

175

Clo sing brace (curly bracket)

~

7E

126

176

Tilde

7F

127

177

Delete (rubo ut)

80

128

200

--to be defined--
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81

129

201

--to be defined--

82

130

202

--to be defined--

83

131

203

--to be defined--

84

132

204

--to be defined--

85

133

205

--to be defined--

86

134

206

--to be defined--

87

135

207

--to be defined--

88

136

210

--to be defined--

89

137

2 11

--to be defined--

8A

138

212

--to be defined--

8B

139

213

--to be defined--

8C

140

214

--to be defined--

8D

141

215

--to be defined--

8E

142

216

--to be defined--

8F

143

217

--to be defined--

90

144

220

--to be defined--

91

145

221

--to be defined--

92

146

222

--to be defined--

93

147

223

--to be defined--

94

148

224

--to be defined--

95

149

225

--to be defined--

96

150

226

--to be defined--

97

151

227

--to be defined--

98

152

230

--to be defined--

99

153

231

--to be defined--

9A

154

232

--to be defined--

9B

155

233

--to be defined--
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9C

156

234

--to be defined--

9D

157

235

--to be defined--

9E

158

236

--to be defined--

9F

159

237

--to be defined--

A0

160

240

--to be defined--

À

A1

161

241

Uppercase A grave accent

Â

A2

162

242

Uppercase A circumflex

È

A3

163

243

Uppercase E grave accent

Ê

A4

164

244

Uppercase E circumflex

Ë

A5

165

245

Uppercase E umlaut o r diaeresis

Î

A6

166

246

Uppercase I circumflex

Ï

A7

167

247

Uppercase I umlaut o r diaeresis

´

A8

168

250

Acute accent

`

A9

169

251

Grave accent

^

AA

170

252

Circumflex accent

"

AB

171

253

Umlaut (diaeresis) accent

~

AC

172

254

Tilde accent

Ù

AD

173

255

Uppercase U grave accent

Û

AE

174

256

Uppercase U circumflex

AF

175

257

Italian lira symbo l

—

B0

176

260

Over line (high line)

Ý

B1

177

261

Uppercase Y acute accent

ý

B2

178

262

Lo wercase y acute accent

º

B3

179

263

Degree (ring)

Ç

B4

180

264

Uppercase C cedilla

ç

B5

181

265

Lo wercase c cedilla

Ñ

B6

182

266

Uppercase N tilde

G-9
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ñ

B7

183

267

Lo wercase n tilde

¡

B8

184

270

Inverse exclamatio n mark

¿

B9

185

271

Inverse questio n mark

BA

186

272

EURO symbo l

£

BB

187

273

British po und sign

¥

BC

188

274

Japanese yen symbo l

§

BD

189

275

Sectio n sign

ƒ

BE

190

276

Dutch guilder symbo l

¢

BF

191

277

U.S. cent symbo l

â

C0

192

300

Lo wercase a circumflex

ê

C1

193

301

Lo wercase e circumflex

ô

C2

194

302

Lo wercase o circumflex

û

C3

195

303

Lo wercase u circumflex

á

C4

196

304

Lo wercase a acute accent

é

C5

197

305

Lo wercase e acute accent

ó

C6

198

306

Lo wercase o acute accent

ú

C7

199

307

Lo wercase u acute accent

à

C8

200

310

Lo wercase a grave accent

é

C9

201

3 11

Lo wercase e grave accent

ò

CA

202

312

Lo wercase o grave accent

ù

CB

203

313

Lo wercase u grave accent

ä

CC

204

314

Lo wercase a umlaut o r diaeresis

ë

CD

205

315

Lo wercase e umlaut o r diaeresis

ö

CE

206

316

Lo wercase o umlaut o r diaeresis

ü

CF

207

317

Lo wercase u umlaut o r diaeresis

Å

D0

208

320

Uppercase A degree

î

D1

209

321

Lo wercase i circumflex
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Ø

D2

210

322

Uppercase O cro ssbar

Æ

D3

2 11

323

Uppercase AE ligature

å

D4

212

324

Lo wercase a degree

í

D5

213

325

Lo wercase i acute accent

ø

D6

214

326

Lo wercase o cro ssbar

æ

D7

215

327

Lo wercase ae ligature

Ä

D8

216

330

Uppercase A umlaut o r diaeresis

ì

D9

217

331

Lo wercase i grave accent

Ö

DA

218

332

Uppercase O umlaut o r diaeresis

Ü

DB

219

333

Uppercase U umlaut o r diaeresis

É

DC

220

334

Uppercase E acute accent

ï

DD

221

335

Lo wercase i umlaut o r diaeresis

ß

DE

222

336

Sharp s

Ô

DF

223

337

Uppercase O circumflex

Á

E0

224

340

Uppercase A acute accent

Ã

E1

225

341

Uppercase A tilde

ã

E2

226

342

Lo wercase a tilde

Ð

E3

227

343

Uppercase D with stro ke

ð

E4

228

344

Lo wercase d with stro ke

Í

E5

229

345

Uppercase I acute accent

Ì

E6

230

346

Uppercase I grave accent

Ó

E7

231

347

Uppercase O acute accent

Ò

E8

232

350

Uppercase O grave accent

Õ

E9

233

351

Uppercase O tilde

õ

EA

234

352

Lo wercase o tilde

S

EB

235

353

Uppercase S with caro n

s

EC

236

354

Lo wercase s with caro n
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Ú

ED

237

355

Uppercase U acute accent

Ÿ

EE

238

356

Uppercase Y umlaut o r diaeresis

ÿ

EF

239

357

Lo wercase y umlaut o r diaeresis

Þ

F0

240

360

Uppercase Tho rn

þ

F1

241

361

Lo wercase tho rn

F2

242

362

--undefined--

F3

243

363

--undefined--

F4

244

364

--undefined--

F5

245

365

--undefined--

—

F6

246

366

Lo ng dash (ho rizo ntal bar)

¼

F7

247

367

One fo urth (o ne quarter)

½

F8

248

370

One half

F9

249

371

Feminine o rdinal indicato r

FA

250

372

Masculine o rdinal indicato r

«

FB

251

373

Opening guillemets (angle quo tes)

•

FC

252

374

So lid

»

FD

253

375

Clo sing guillemets (angle quo tes)

FE

254

376

P lus/minus sign

FF

255

377

--undefined--
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GLOSSARY
Some of the networking and data processing terms in this documentation
may not be familiar to some users. To help we have provided descriptions of some of the most common networking and data processing terms
below.
802.3
IEEE protocol covering the data link layer. (The international
standard is known as 802.3.) While 802.3 is physically compatible
with standard Ethernet (it can operate concurrently with standard
Ethernet over the same cable), 802.3 uses a slightly different form of
packet header, so not every computer using Ethernet hardware can
support both standard Ethernet and 802.3.
access method
The way in which a device on a LAN achieves access to the LAN to
transmit data. Examples include token-passing and CSMA/CD.
ACK
(acknowledgment). A response sent by a receiver to indicate successful receipt of information. Acknowledgments can be implemented at any level including the physical level (using voltage on
one or more wires to coordinate transfer), the link level (to indicate
successful transmission across a single hardware link), or higher
levels (for example, to allow an application program at the final
destination to respond to an application program at the source).
address
A numeric identification for a particular node, storage location, or
device.
address resolution
The conversion to the address of a physical location from a virtual
address, such as on the Internet.
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ALT
Alternate. A key that, when pressed, signals the computer of a
change in the meanings of other keys struck in conjunction with it.
ANSI
(American National Standards Institute). A U.S. group that establishes standards in the computer industry.
API
(Application Program Interface). The transparent interface used by a
software application for communications between a programming
language and the application’s files and processes.
application layer
The highest layer in the seven-layer Open Systems Interconnect
(OSI) model. It controls application programs.
architecture
How the hardware and software in a computer or network are set up
to work together.
ARP
(Address Resolution Protocol). A process used by the TCP/IP
protocol to map IP addresses to Ethernet addresses. Required for
TCP/IP use with Ethernet.
ASCII
(American Standard Code for Information Interchange). The most
common coding system for converting letters, numerals, and other
symbols into a form usable by computers and peripherals.
ASCII file transfer
A seven-bit transfer of text files that are presented in ASCII form.
asynchronous transmission
A method of communication in which the intervals between characters are of uneven length.

II
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background
A background program is one that is not currently the focus of user
input via a keyboard or mouse, but which remains operating while
the user works on another program.
background processing
Work performed by a program while in background.
bandwidth
A term used to describe the range of transmission frequencies used
by a network. A wider bandwidth transmits more data in the same
time than a narrower one.
baud rate
The rate at which data is transmitted, approximately equivalent to
bits per second.
binary file transfer
A file transfer mode that transmits a file containing binary characters
without loss of data.
block mode
A facility, available only on some terminals, whereby data on a
screen can be edited locally and transmitted as a block when the user
has finished, rather than character by character.
bps
(bits per second). The rate at which data flows in communications.
broadcast
A delivery system that broadcasts a given packet to all hosts attached. Implemented in hardware or software.
carrier signal
A signal that is set by a modem on pin 8 of an RS-232 cable to
indicate that a connection has been established with another modem,
thus permitting data communication.
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CCITT
(Consultative Committee for International Telephony and Telegraphy). An international organization that develops communications
standards.
character mode
A terminal operation mode where each character is transmitted to the
host as its key is pressed on the keyboard.
CI
(Command Interpreter). A program that reads lines of text from
standard input (entered at the keyboard or redirected from a file) and
interprets them as requests to perform functions or execute other
programs.
clear to send (CTS)
A signal transmitted from modem to terminal stating that the modem
is ready to accept data for transmission.
command language
A language that is specific to a particular application and that is
generally used to provide a simplified way of executing a series of
common commands, such as log-on sequences, dialing modems,
initiating file transfers, and other tasks.
control character
A non-text character that directs the computer to take an action, such
as line feed or carriage return.
Ctrl
The Control key, also expressed as ^. Holding down the Control key
changes the meaning of other keys struck in conjunction with it.
cursor
A symbol on the screen, in the form of a blinking line or rectangle,
that indicates where the next typed character will be displayed.
datacomm
Short for data communications, the act of transmitting data from its
source to peripheral equipment or to another computer.

IV
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data set ready (DSR)
A signal that is set by a modem on pin 6 of an RS-232 cable to
indicate that the modem is ready to receive and transmit data. Most
modems automatically set this signal on as soon as power is applied
to the modem.
data terminal ready (DTR)
A signal set on by a terminal on pin 20 of an RS-232 cable to
indicate that the terminal is ready for data communication. Some
modems terminate a telephone connection after this signal has been
absent for a certain period of time.
DCE
(Data Communications Equipment). Modems and other intermediate
communications devices (distinguished from DTE).
DDE
(Dynamic Data Exchange). A protocol for data exchange between
Microsoft Windows programs.
device
Also known as hardware. Any physical piece of electronic equipment, such as a PC, terminal, or component.
device driver
A section of code that acts as a gateway between the operating
system and a physical device, such as a serial port.
disconnect
To terminate a network session. Disconnecting does not necessarily
log you off a host computer.
display memory
That portion of a terminal’s memory that stores received data.
Display memory is what is shown on the screen.
DLL
(Dynamic Link Library, also known as Data Link Layer). A set of
program routines that are available to applications at run time.
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domain
A name used to identify a group of machines. Also used by NS/3000
on HP e3000 computers as part of a fully qualified network interface
name.
DOS
Disk Operating System. Operating system developed by Microsoft
for personal computers.
DOS device driver
A program, such as a LAN card driver, that can be loaded into
memory with a DEVICE= command in the CONFIG.SYS or
AUTOEXEC.BAT files.
download
The process of transferring data from another system to your own.
DTE
(Data Terminal Equipment). Terminals and other devices that are the
source or final destination of data; as opposed to DCE devices,
which are intermediate communications devices.
echo
A function whereby a computer immediately returns each character
as it is received. Echo can be used to confirm receipt.
ENQ
(Enquiry). A special character, ASCII code 5, used to ask for ACK
or NAK. It may be part of the initialization sequence or the final
character of a polling sequence.
environment
A computer’s specific configuration, CPU model, installed software
collection, or operating system.
escape sequence
A character string that begins with the ASCII escape character and
that contains a command, such a printer or modem initialization.

VI
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field
A part of a record designed to hold one category of data. For example, a mailing list would contain fields for name, address, and zip
code.
file
A body of data stored at one location on a hard disk or floppy
diskette under a unique filename. A file can contain random data,
such as text, or can be organized as records, which in turn would
contain one or more fields.
fixed-length record format
A file format in which all records have the same length.
flow control
A stop-and-start mechanism used to govern the flow of data to make
sure the receiver can process what has already been sent before
further data is transmitted.
full duplex
The data communications mode that allows simultaneous two-way
communication.
gateway (router)
A machine that connects two or more networks using different
network protocols, performing the necessary protocol conversions.
half duplex
Communication in two directions but not at the same time.
handshake
An ‘agreement’ between two computers that sets up how they will
communicate with each other and exchange data.
host
A server, minicomputer, or mainframe that can be accessed by a
terminal or PC.
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hostid
The part of a network address that is exclusive to a particular host.
Also known as an IP address.
host name
A textual identification for a particular machine. The fully qualified
form usually consists of “name.domain.organization”.
Hosts file
An ASCII file of Internet addresses of hosts.
IEEE
(Institute of Electrical and Electronic Engineers). A standards-setting
body that is responsible for 802-series standards. (802.3 refers to
CSMA/CD [Ethernet]; 802.4 refers to a token-passing bus; 802.5
refers to a token-passing ring [e.g., IBM’s Token-Ring].)
internet
A linked network of networks.
Internet
A worldwide network of networks that uses the TCP/IP protocol
suite.
Internet address
The specific 32-bit address assigned to each host participating in the
Internet.
IP
(Internet Protocol). A public standard that specifies the format of
data for transmission on the Internet. Commonly used in conjunction
with TCP to form TCP/IP.
IP address
See Internet address.
ISO
(International Standards Organization). The international organization that develops standards for computers and other fields.

VIII
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LAN
(Local Area Network). A system connecting a number of communication devices in one location.
LANIC
(Local Area Network Interface Controller). A hardware card that fits
into an HP e3000 and provides a physical interface for IEEE 802.3
local area networks.
line driver
A device that extends the distance over which digital transmissions
can be made from terminals and computers that are linked via
private lines.
linefeed
An ASCII control character that moves the cursor or the form
(paper) to the next line.
local mode
A loopback operation where data entered at a terminal is not transmitted to a host computer, but is displayed on the terminal’s screen.
local node
A PC or workstation attached to a host computer.
modem
A modem converts digital signals from a computer to analog (sound)
signals for transmission over a phone line, and converts analog
signals received through a phone line to digital signals.
MPE
Operating system of the HP e3000 minicomputer. MPE stands for
Multi Programming Executive.
multicast
A technique that allows copies of a single packet to be passed to a
selected subset of possible destinations, i.e., to those devices that are
“listening” for it.
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multicast address
An address used to designate all nodes that “listen for” a particular
message.
multiplex
A method whereby several devices can share a single communications channel.
multitasking
Running two or more programs or performing two or more functions
at the same time.
NAK
(Negative Acknowledgment). A character (ASCII code 21 decimal)
sent to indicate errors in a received transmission. See ENQ, ACK.
name
In the NS/VT environment, one of three address components, along
with domain and organization, that define a node.
NDIS
(Network Driver Interface Specification). A specification that
defines the interface between the transport protocols and the network
card. NDIS was developed by Microsoft and 3Com.
NetBIOS
(Network Basic Input Output System). A standard network interface
specification for PC local area networks introduced with IBM’s PC
Network and used by Microsoft’s LAN Manager.
netid
The first portion of a TCP/IP network address, consisting of network
identification bits that are shared by the network the machine is on
(as opposed to the hostid which identifies the host).
NetWare
Novell’s line of network operating systems. NetWare uses Novell’s
proprietary IPX protocol to route messages.

X
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network address
A special address that refers to a network as an entity, consisting of a
netid and hostid, with the hostid consisting of all zero bits.
node
Nodes are devices that have network interfaces. Nodes include HP
e3000s, PCs, routers, servers, communication servers, and just about
anything else that needs to communicate across the network.
NS/VT
(Network Services/Virtual Terminal). A protocol from HewlettPackard used on HP e3000 machines for an IEEE 802.3 LAN or
inter-network.
null modem
A cable arrangement in asynchronous serial communications directly
connecting two pieces of terminal equipment with RS-232 cable so
that the sending wire on one end becomes the receiving wire on the
other end.
ODI
(Open Datalink Interface). Novell’s specification for a protocol-todriver interface. ODI is a set of specifications that lets multiple
communication protocols such as IPX/SPX and TCP/IP share the
same driver and network interface card adapter.
operating system
A master control program for a computer that manages basic operations, including apportioning memory, ordering tasks, and managing
the flow of information into and out of the main processor. The
central core remains in memory at all times. The operating system
sets the standards for application programs running on it.
OSI model
(Open Systems Interconnection model). A seven-layer model for
describing network protocols developed by the ISO.
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packet
A group of data elements transmitted together than generally forms
part of a larger transmission made up of a number of packets. A
packet is made up of additional information, such as packet number
and error-detecting codes.
packet header
The portion of the packet that contains the control information:
destination, origin, length, etc.
packet switching
A method of communication that involves splitting a transmission up
into packets. Successive packets along a given channel can belong to
different transmissions.
parallel port
A communication port through which data moves more than one bit
at a time.
parallel transmission
The movement of data more than one bit at a time. This is accomplished by a cable that has a separate line for each bit position. For
example, the IBM PC’s parallel printer interface sends eight bits
(one byte) in parallel.
parity
An error-detection method that adds a non-information bit to each
character transmitted. The parity bit is computed from the data bits
by both the transmitting and receiving devices, and the result is then
compared. The bit may be always 0 (space parity), always 1 (mark
parity), or either 0 or 1 so as to make the sum of the bits odd (odd
parity) or even (even parity).
peer
A functional unit that uses the same protocol layer as another.
peer-to-peer communications
Communication from one user to another user on a network.

XII

MINISOFT 92

GLOSSARY

peer-to-peer network
A local area network in which all machines have equal access to the
others’ resources for cooperative processing.
PING
A program that tests a TCP/IP network node by sending an echo
request and waiting for a reply. (Also used as a verb.)
port
A jack or outlet on a computer where connectors to peripheral
devices or networks are attached; a virtual point-of-connection into
TCP or UDP.
Probe protocol
A Hewlett-Packard protocol used by nodes on NS3000 IEEE 802.3
networks to obtain information about other nodes on the network.
Probe translates between HP Network Services node names and both
Internet and Ethernet addresses.
protocol
A formal set of standards covering data communications.
protocol stack
Protocols that specify the rules for computer-to-computer communications.
proxy ARP
A TCP/IP technique in which one machine; usually a gateway,
answers address resolution protocol requests intended for another
machine by supplying its own physical address. Used as a way to
avoid forming a subnet.
remote mode
A mode of terminal operation in which data is transmitted to and
received from a host computer.
request to send (RTS)
A signal from a terminal to a modem indicating that the terminal is
wanting to send data.
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router (gateway)
A network computer that makes decisions about which path, out of
several, network traffic is to follow; the computer then moves
packets along the selected path.
RS-232
A standard cable type used to connect data communications equipment. A 9-pin or 25-pin connector is typically used. (Also known as
RS-232-C.)
serial port
A communications port through which data moves over a single
wire, one bit after another.
serial transmission
The transmission of data as a sequence of bits, one bit at a time.
server
In the client/server model, a server is the application that provides
the service requested by another application. On a PC LAN, a server
is usually a dedicated PC that offers services such as disk space,
printers, host computer access, and applications.
session layer
The OSI layer concerned with providing a way for session users to
establish connections (sessions) and transfer data over them in an
orderly way.
SLIP
(Serial Line Internet Protocol). Allows IP to operate over serial (dialup) lines. It requires a relatively high speed (9.6Kbps or faster)
connection.
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socket
An IP socket is created when an IP port on a host machine makes a
connection to an IP port on a client machine. IP sockets are ephemeral by nature. When a standard request port has formed a socket
connection to a standard services port, additional requests for access
to that port may be denied, returning the Socket request denied error
message, which is often seen when attempting connections to
popular Internet WWW host sites.
star topology
A LAN architecture in which the network devices connect to a
centralized controller or hub.
start bit
A bit sent in asynchronous communications indicating the start of a
new character.
status request
A request issued by a host computer for information from a terminal.
An aid to communication between terminal and host.
stop bit
A bit sent in asynchronous communications indicating the end of a
character.
string
A set of characters transmitted or received together, such as a
password.
subnet
Subnet or network mask is a term used for dividing an A or B class
address into multiple smaller networks.
subnet address
An extension of the Internet addressing scheme that allows a site to
use a single Internet address for more than one physical network.
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subnetid (or subnet address)
The assignment of bits in a portion of the host id to designate a
particular physical network as a site with a single network identification and multiple physical networks. Only the local gateways
recognize the subnet address.
synchronous transmission
The transmission of a sequence of data elements at regularly spaced
intervals without the use of start and stop bits framing each character.
TCP
(Transmission Control Protocol). The Internet standard transportlevel protocol, providing reliable full duplex stream service. TCP
allows a process on one machine to send a stream of data to a
process on another. Software implementing TCP uses the IP protocol
to transmit information. TCP establishes a virtual circuit and provides reliable end-to-end data transmission.
TCP/IP
(Transmission Control Protocol/Internet Protocol). Specifically, this
term denotes the combination of TCP and IP; more generally, it
refers to the Internet Protocol Suite, which includes TCP and IP, as
well as several other protocols. TCP/IP has been implemented on
several operating systems.
Telnet
An Internet protocol, used in conjunction with TCP/IP, that allows a
computer to act as a terminal on a network.
terminal
A device that can be used to input, to receive, and to display data
from a host computer.
terminal emulator
A software program that allows a personal computer to behave as
though it is a terminal. A desktop computer running a terminal
emulation program may be used in place of a terminal.
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terminal server
A device that allows the input/output of multiple terminals to be
multiplexed onto LAN cable.
text file
A file consisting only of readable data; it contains no formatting
information.
timeout
The process in which an intended operation is assumed to have
failed because it was not completed within the time allotted.
Token-Ring
An IBM-designed local area network that has ring topology and uses
token passing (a method of network transmission in which network
devices pass along a certain sequence of bits (“token”) from device
to device. Only the device that has the token can transmit information along the network at a given point in time.)
topology
The general physical layout of a network (although it does not
specify cable type, number of nodes, etc.). Examples include star
topology, ring topology, and bus topology.
transport layer
The OSI layer concerned with controlling a communication transaction between nodes (user-to-user communication).
twisted pair cable
Telephone wire; sometimes referred to as RJ 11, although an RJ 11
is actually a connector. Ethernet can be run on twisted pair cable.
type-ahead
A feature that allows a user to enter data at the keyboard before
being prompted by the host computer.
UART
(Universal Asynchronous Receiver/Transmitter). A chip with serial/
parallel conversion, parallel/serial conversion, and other facilities
designed for use in asynchronous serial communications.
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upload
The process of moving data from your computer to another system.
vector
Short for interrupt vector. PCs provide over 250 different interrupt
vectors that may be used to pass control to software routines. Some
vectors are associated with hardware interrupts (IRQs).
virtual circuit
A communications link that acts as though it is a dedicated point-topoint circuit. Also, a system that delivers packets so that they appear
in sequence as though they were sent over a real point-to-point
circuit.
virtual disk
A disk simulated in random access memory (RAM).
virtual network
A network that is programmed, not hard-wired, to a customer’s
specifications. Also called a Software Defined Network by AT&T.
WAN
A Wide Area Network (WAN) is two or more LANs tied together.
The LANs’ areas are usually in different cities or states. It would be
very rare to have only one IP network on a WAN.
wildcard
In MS-DOS, the symbol ? is used in place of single characters in
filenames or extensions, and * is used in place of whole or partial
filenames or extensions, indicating all for the given field.
WinSock
Windows Sockets (WinSock) is a specification for network programming of Berkeley Software Distribution (BSD) style sockets in the
Microsoft Windows environment. The sockets programming interface was introduced in 4.1 BSD Unix and was designed to eliminate
the need to program the lower-level details of a network interface.
Many Unix and non-Unix network platforms adopted this interface,
providing a de facto standard for network programming.
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Both network stack providers and application developers recognize
that in order for network application developers to support multiple
protocol stacks, they would have to program to each vendor’s
proprietary Application Programming Interface (API). Because of
sockets’ API popularity and the popularity of Microsoft Windows, a
group of network programmers that gathered at Interop91 decided
there was a need for an open specification for network programming,
and that a common binary interface could be achieved through the
use of a Windows dynamic link library (DLL). The WinSock
specification allows application developers to write one application
that can be executed over any vendor’s TCP/IP stack. This meeting
planted the seed that is now the WINSOCK.DLL.
Xmodem
A protocol designed for transfers between microcomputers.

MINISOFT 92

xix

Index

INDEX

Symbols
132 / 200 column 2-26

A
Action on disconnect 2-20
Auto wrap 3-23
Auto-size font 2-16
Automating NFT 6-16
Visual Basic 6-16
Visual C++ 6-16

B
Baud rate 4-4
block mode enter C-15
Break 8-3
Breaking a connection 8-3
Button bar 2-11, 3-5
Bypass windows scrolling 2-26

C
Capture to disk 7-16
Center screen 2-26
Clearing text 3-19
Closing session 3-14
Color configuration 2-28
HP MODE 2-28
VT MODE 2-28
Comms status report 8-9
Configuration buttons for fonts 3-5
configuration file 2-3
Configuration operations C-8

MINISOFT 92

Configure WS92LINK 6-4
Configuring
connection 2-8
interface 2-11
login in NFT 6-22
MS92 2-3
one copy executable 1-5
status bar in VT mode 3-24
WinSock connection 5-5
Confirm Quit on Close Screen 2-20
Connecting serially 4-3
Connection trace 8-8
Control Codes E-1
Copy 3-16, 7-17
Copy All 7-14
Copy Line 7-13
Copy Page 7-14
Copying text 3-16
Creating shortcut icons 2-5
Cursor control operations C-8
Cursor keys 3-24
Cursor shape 2-25
Custom menu 2-13

D
Data bits 4-4
Data operations C-11
DDE 2-20
Debug mode 8-7
Debugging problems 8-6
Comms status report 8-6
Connection trace 8-6
Debug mode 8-6
Event trace 8-6
i

Index

Packet capture 8-6
DEC terminal 3-21
Default configuration 2-3
Default.W92 2-3
Defining function keys C-13
Deleting lines 3-18
Destr. B-Space 2-19, 2-22
Device control keys 3-11
Device modes keys 3-12
Direct serial connection 4-3
Disabling function keys C-13
Disconnect 8-3
Disconnect from network 2-20
Display enhancements C-16
Downloading a file 6-9
Downloading file with NFT 6-22
Dynamic Data Exchange 2-20

E
Emulating a DEC terminal 3-21
Enabling function keys C-13
Enter in block mode 2-19, C-15
Error Messages
Font installation A-6
Initial execution of MS92 A-7
Installing WS92 A-6
Losing a connection A-3
Running a command language A-3
Transferring files A-4
WinSock connections A-6
Escape Sequences C-1
EURO Symbol 2-36
Event trace 8-7

F
File transfer 6-3
errors A-4
FnKey Default Setting 2-25
Font configuration 2-16
FTP engine F-9
Function key operations C-13
Function keys 3-6, 3-8

II

G
Glossary B-3, i

H
Handshaking 2-10, 4-4
Hard reset 8-5
Hardware requirements 1-3
Help 3-20
Host data to a local printer 7-9
Host data to a pc file 7-16
Host-initiated commands C-17
HP function keys 3-23
HP MODE 2-28

I
Ignore host commands 2-19
Ignore unsupported cmds 2-19
Inserting lines 3-18
Installation of MS92 1-4
Installing
NFT 6-14
NFT on the HP3000 6-14
Interface Configuration 2-11
IP Addresses B-3
IP Networks B-3
IP Node Address B-3
IP Router B-3
Setting up Novell server B-3

K
Keyboard mapping 2-31
Keypad 3-24

L
LAN B-3
Line/Page Mode 2-10
Loading configuration file 2-4
Local Area Network B-3
Local printer 7-5
Log Bottom 7-11
Log Top 7-9
Losing a connection A-3
MINISOFT 92

Index

M
Macro Language F-1
Manipulating text 3-16
Map form feeds to line feeds 2-27
Mapping VT keys in WS92 3-25
Menu bar 3-4
Minisoft protocol options 6-5
Modem connection 4-5
Modem dialer 4-7
Modes keys 3-8
MS92 Features v
MS92 versions 1-3

Print Driver 7-6
Printer fonts 7-8
Printer fonts using windows default 7-8
Printer Init 7-6
Printer Reset 7-6
Printer Selection 7-6
Printing configuration 7-3
Host printer 7-9
Local printer 7-5
Printing from NMCONFIG 8-10
DTC configuration 8-10
NETXPORT (TCP/IP) 8-10
Printing from PC to host printer 7-17

N

R

Network disconnection 2-20
Network File Transfer 6-3, 6-14
Network mask B-4
NFTJOB 6-15
NFT’s OLE Automation F-1, F-3
NMCONFIG 8-10
NMMGR B-3
Configuring a Gateway B-3
Configuring a Router B-3
Nodes B-3

Raw keys 2-19
Record mode 7-12
Remote File Name 6-9
Requirements 1-3
Resetting a connection 8-3
Return = Enter in Block Mode 2-19
RETURN key C-10
Right mouse button 2-21
Running
command language A-3
command line for config file 2-5
NFT 6-17
WS92 1-7

O
OLE automation engines from Visual C++
F-14
one session executable 1-5
Opening a session 3-14
Operating NFT on the HP3000 6-15

P
Packet capture 8-8
Parity 4-4
Paste 7-17
paste 3-16
Pasting text 3-16
PC Install 1-4
Pointer (cursor) 3-5
Port 4-4

MINISOFT 92

S
Satus bar in VT mode 3-24
Save file info 6-10, 6-11
Saving a configuration 2-7
Screen
configuration 2-21
options 2-9
pages 2-25
width 2-25
Scroll bars 2-26
Scroll Jumps 2-25
Sending host data to a local printer 7-9
Sending host data to a pc file 7-16

iii

Index

Serial connection 4-3
Serial numbers 2-18
Set statement 1-5
Setting up Novell server as IP router B-3
Show attributes 2-29
Show scroll bar 2-26
Soft reset 8-4
Software requirements 1-3
Special configuration 2-17
splash screen
eliminated 1-5
Squeeze 132 column font 2-16
Starting WS92 1-7
Status bar 2-11, 3-5
Stripe Carriage Control 6-6
Subnet B-4
Support 8-bit controls 3-23
Suppress Automatic Spooling 7-7
Suppress bell 2-19
Suppress blinking 2-27
Suppress Form Feed on Close Printer 7-7
Suppress Run Command 6-6
Suppress true underlining 2-26
System keys 3-13

T
TCP/IP stack 1-5
Terminal configuration 2-8
Terminal configuration in HP mode 2-8
Terminal configuration in VT mode 3-23
Terminal escape sequences C-10
Terminal functions C-3
Terminal ID 2-9
Text font for function keys 2-27
Title bar 2-25, 3-4
Transferring files A-4
File transfer error A-4
Upload host program errors A-4
Translation tables 2-35

U
Upload host program errors A-4
Uploading
ASCII files 6-13
File 6-11
file with NFT 6-19
WS92LINK to host 6-7
User-defined keys 3-6

V
Visual BASIC F-9
VT keys mapping 3-25
VT MODE 2-28

W
WAN B-3
Wide Area Network B-3
WinSock 1-3
WinSock PC requirements 5-3
WinSock requirements 5-3
Host requirements 5-4
NS/VT 5-4
Telnet 5-4
Wrap keyboard selections 2-27
Wrap shift mouse selection 2-27
WS92 configuration 2-3
WS92 modem connection 4-5
WS92LINK 6-3, 6-4
Ctrl Z 6-5
Default to ASCII 6-5
If file exists 6-6
Protocol 6-5
Protocol options 6-5
Record size 6-5
Timeout 6-5
Trailing spaces 6-5

X
XLAT files 2-38
Xmodem 6-3

IV

MINISOFT 92

